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Support and other contacts

United States and Canada

Europe

Pacific

Contact Honeywell IAC Solution Support Center

Phone 1-800 822-7673. In Arizona: (602) 313-5558
Calls are answered by dispatcher between 6:00 am and 4:00 pm Mountain 
Standard Time. Emergency calls outside normal working hours are 
received by an answering service and returned within one hour.

Facsimile (602) 313-5476 

Mail Honeywell IS TAC, MS P13
2500 West Union Hills Drive
Phoenix, AZ, 85027

Contact Honeywell TAC-EMEA

Phone +32-2-728-2704

Facsimile +32-2-728-2696

Mail Honeywell TAC-EMEA
Avenue du Bourget, 1
B-1140 Brussels, Belgium

Contact Honeywell Global TAC - Pacific

Phone 1300-300-4822 (toll free within Australia)
+61-8-9362-9559 (outside Australia)

Facsimile +61-8-9362-9169

Mail Honeywell Global TAC - Pacific
5 Kitchener Way
Burswood, WA, 6100, Australia

Email GTAC@honeywell.com
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India

Korea

People’s Republic of China

Contact Honeywell Global TAC - India

Phone +91-20-2682-2458 / 1600-44-5152

Facsimile +91-20-2687-8369

Mail Honeywell Automation India Ltd.
56 and 57, Hadapsar Industrial Estate
Hadapsar, Pune -411 013, India

Email Global-TAC-India@honeywell.com

Contact Honeywell Global TAC - Korea

Phone +82-2-799-6317

Facsimile +82-2-792-9015

Mail Honeywell Korea,
17F, Kikje Center B/D,
191, Hangangro-2Ga
Yongsan-gu, Seoul, 140-702, Korea

Email Global-TAC-Korea@honeywell.com

Contact Honeywell Global TAC - China

Phone +86-10-8458-3280 ext. 361

Mail Honeywell Tianjin Limited
17 B/F Eagle Plaza
26 Xiaoyhun Road
Chaoyang District
Beijing 100016, People’s Republic of China

Email Global-TAC-China@honeywell.com
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Singapore

Taiwan

Japan

Elsewhere
Call your nearest Honeywell office.

World Wide Web
To access Honeywell Solution Support Online, do the following:

1 In your web browser, type the address http://www.honeywell.com/ps.

Contact Honeywell Global TAC - South East Asia

Phone +65-6580-3500

Facsimile +65-6580-3501
+65-6445-3033

Mail Honeywell Private Limited
Honeywell Building
17, Changi Business Park Central 1
Singapore 486073

Email GTAC-SEA@honeywell.com

Contact Honeywell Global TAC - Taiwan

Phone +886-7-323-5900

Facsimile +886-7-323-5895
+886-7-322-6915

Mail Honeywell Taiwan Ltd.
10F-2/366, Po Ai First Rd.
Kaohsiung, Taiwan, ROC

Email Global-TAC-Taiwan@honeywell.com

Contact Honeywell Global TAC - Japan

Phone +81-3-5440-1303

Facsimile +81-3-5440-1430

Mail Honeywell K.K
1-14-6 Shibaura Minato-Ku
Tokyo 105-0023
Japan

Email Global-TAC-JapanJA25@honeywell.com
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2 Click Login to My Account and then log on.

3 Move the pointer over Contacts & Support in the top menu bar and then 
choose Support from the popup menu.

Training classes
Honeywell holds technical training classes on Experion. These classes are taught 
by experts in the field of process control systems. For more information about 
these classes, contact your Honeywell representative, or see http://
www.automationcollege.com.

Related documentation
For a complete list of publications and documents for Experion, see the Experion 
Overview.
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1About this guide

This guide describes how to use Station to monitor and control your Experion 
system.
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How to use this guide

To learn about: Go to:
The basics, such as the layout of the screen and how to use your keyboard page 17

Responding to alarms page 65

Responding to events page 81

Responding to messages page 95

Responding to alerts page 105

Monitoring system status page 133

Generating and printing reports page 151

Using the Message Pad page 149

Loading recipes page 129
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RELATED DOCUMENTATION

Related documentation
If your system has process points, then you should also read the:

• C300 Controller User’s Guide

• Sequential Control User’s Guide

• Control Building User’s Guide

If your system has the Legacy IO Link module then you should also read the LCS 
621 IO Integration Guide LCS02100A.
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2Understanding the basics

Every Experion system is configured to meet a particular set of requirements. 
This means that some of the information in this guide may not be applicable to 
you, or may operate in a slightly different way. Consequently, you should ask 
your supervisor or an experienced colleague before you perform any procedure 
described in this guide.
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Introducing Experion and Station
Experion is a sophisticated management and control application that:

• Displays system data in a manner that you can easily understand

• Allows you to control your system by sending appropriate commands

• Automatically performs scheduled tasks

• Notifies you of system activities, including alarms and system events

• Produces comprehensive reports

The following figure shows a typical Experion system. Experion runs on the 
server—the main computer—which collects and processes data, administers 
system activities and performs automated tasks.

The system interfaces, point servers and controllers are the “hands and eyes” of 
your system, controlling and collecting data from your plant equipment.

A system interface or point server collects information from the field and sends 
this information to the Experion system upon request. In general, this information 
is not stored in Experion unless you are collecting history. 

Controllers also collect information from the field but continually send this 
information to the Experion system where it is stored.

In most cases, the controllers are located near the devices they control, and are 
connected to the server via a LAN (Local Area Network) or other communication 
link.

Server

Reports

Alarms

StationStation

Controller Controller

LonWorks 
Point Server

LON Bus
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Introducing Station
A Station is, in effect, a set of “control panels” through which you and your 
colleagues monitor and control your system. (Station is a separate Experion 
program that runs on standard computers, as well as on the server.) 

Station presents information as a series of displays—each display is a “control 
panel” that shows a particular set or type of information, and has an appropriate 
set of controls, such as “buttons” and “scroll bars”.

There are two basic types of display:

• System. These are supplied with Experion and show information in a 
standardized manner. For the most part, system displays consist of lists and 
“electronic forms” containing system configuration details.

• Custom. These have been created specifically for your system, and make it 
much easier to interpret and control system activity, often making use of 
sophisticated graphics, including animations. 

In addition to displays, Station can display Web pages and files, such as Microsoft 
Word documents, which typically contain operating procedures.

Figure 1 A typical system display
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What type of Station do you use?
There are several different types of Station, these are:

In addition to a single instance of Station appearing in a single monitor, there are 
two potential configurations of Station for multiple monitors: 

• Multi-window Station. Allows you to view multiple displays at one time and 
manage where and how displays are placed on a desktop that spans two or 
four monitors. 

• Multiple static Station. Allows you to have up to four instances of Station 
running simultaneously on one computer. With this configuration, you can 
position an instance of Station in each monitor. 

Figure 2 A typical custom display

Station type Description
Flex Station Station connected to an Experion server.

Console Station Station connected to an Experion server as well as 
connected directly to devices such as Process 
Controllers. If the Experion server is not operational, 
Console Station can still view and control the part of 
your plant to which you are directly connected.

Console Extension Station Station connected to a Console Station.
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The multi-window Station configuration can be used with both a Flex Station and 
a Console Station. The multiple static Station can only be used with a Flex 
Station. 

Both of these configurations can be used in the Icon Series Console environment.

About Console Station and Console Extension Station
A Console Station and Console Extension Station operate in the same manner as a 
Flex Station. However, unlike a Flex Station, most critical operational functions 
can still be performed on a Console Station and Console Extension Station if the 
server is unavailable, for example, when a redundant Experion server fails over to 
the backup server. 

If a Console Station becomes unavailable, operational functions are not available 
on any connected Console Extension Stations. 

What happens when the Experion server is unavailable
If the Experion server becomes unavailable, an alarm is raised on the Console 
Station to indicate that the Console Station is operating in a server unavailable 
mode.

The following table shows the availability of common functions depending on the 
availability of the Experion server.

Function Server available Server unavailable
Log on to Console Station Yes Yes

Log on to Console Extension 
Station

Yes Yes

Change your password using 
Station

Yes Yes, if you are using a Windows based 
user account that is configured in 
Experion.
No, if you are using a traditional 
operator account.

View and control points Yes Yes, if you have points from direct 
data sources, for example, points on a 
Process Controller.

View custom displays Yes Yes, however only data from direct 
data sources is available. 

View and acknowledge alarms 
on the Alarm Summary

Yes Yes, for alarms from direct data 
sources.

Add comments to an alarm Yes No
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Print the Alarm Summary as a 
report

Yes No

View the status of items in the 
System Components tree in the 
System Status display

Yes Yes, for equipment that is directly 
connected to the Console Station, such 
as Process Controllers and Console 
Extension Stations. The status of other 
items is shown as unknown.

View and acknowledge system 
alarms on the System Status 
display

Yes Yes, for equipment that is directly 
connected to the Console Station, such 
as Process Controllers and Console 
Extension Stations. Other alarms are 
shown as questionable.

View faceplates in the Status 
pane on the System Status 
display

Yes Yes, for equipment that is directly 
connected to the Console Station, such 
as Process Controllers and Console 
Extension Stations. 

View and respond to events Yes No

Add comments to an event Yes No

Create operator recorded 
events

Yes No

Print the Event Summary as a 
report

Yes No

Event archiving Yes No

View and respond to messages Yes Yes, for messages from direct data 
sources.

View and respond to alerts Yes No

Load recipes Yes No

Reports Yes No

View trends Yes Yes, real-time trending of points from 
direct data sources.

View Groups Yes Yes, groups with points from direct 
data sources.

Function Server available Server unavailable
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Starting Station
To start Station and log on:
1 From your computer’s Start menu, select either (whichever appears on your 

Start menu):
Start > Programs > Honeywell Experion PKS > Server > Station
Start > Programs > Honeywell Experion PKS > Client Software > Station
Start > Programs > Honeywell Experion PKS > Console Station > Station
Station establishes contact with the server and displays the startup display 
specified in the default setup file.

2 Your system may be set up so that you can select a particular setup file, which 
controls the way Station operates. If this is the case, see “Changing Station’s 
setup file” on page 28.

3 Log on to Station in accordance with the security option used on your system. 
See “What type of security do you use?” on page 24.
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Logging on to Station

What type of security do you use?
Station supports two types of security.

You use: Go to:
Operator-based security if you have been assigned a user name and a 
password or your Station user name and password are the same as your 
Windows user name and password.

page 25

Station-based security if you have not been assigned a user name.
When you start Station, you are automatically assigned OPER security 
level. You can subsequently change to a higher level providing you know 
the password for that level on that Station.

page 27
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Logging on with operator-based security
With operator-based security, there can be several ways to log on, depending on 
how your site is configured.

To log on when a prompt appears:
1 In the Station Operator Logon dialog box type your user name and your 

password.

2 Click OK. 

Asterisks (“*”) appear as you type each character of your password.

To sign on using Signon Manager:
1 Click the Current User window. (If the SignOn User window is hidden, press 

CTRL+ALT+S or click the Current User taskbar icon.) 
The SignOn dialog box opens. 

2 Type your user name.

3 Type your password.

4 Select the appropriate domain if you user account is a domain account.

5 Click Sign On.
The SignOn User window displays the current signed on user.

To sign off:
• In the Current User window, click Signoff.

If you have Then log on to Station
Separate Windows and Station 
user names and passwords

Using Station Operator logon with your Station user 
name and password.

The same user name and 
password for Windows and 
Station

Is automatic if your site is set up to use single signon. 
Otherwise log on to Station using Station Operator 
Logon. Ask your supervisor or experienced colleague if 
your site is set up to use single signon.

Signon Manager Using Signon Manager. Your security details are 
automatically passed to Station when Station starts.

Attention
Your password, but not your user name, is case-sensitive.
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Changing your password

Note:
• Your password must be between 5 and 40 letters/numbers, without spaces.

• Your password is case-sensitive.

To change your password:
1 Type chgpsw in the Command Zone and press ENTER. 

The Change Password dialog box opens.

2 Type your old password and press the TAB key.

3 Type your new password and press the TAB key.

4 Re-type your new password and click OK. (The new password is only 
accepted if the new password entries are identical.)

Logging off
You log off by typing bye in the Command Zone and pressing ENTER.

Attention
Station might be customized to log off automatically if you have not used the keyboard 
for a specified time.
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Logging on with Station-based security
You are automatically assigned OPER security level when you start Station. You 
can change to a higher level providing you know that level’s password for that 
Station.

To change to a higher level:
1 Type psw in the Command Zone and press ENTER. 

The Station Logon dialog box opens.

2 Type the password and click OK.

Logging Off
You only need to log off if you have changed to a security level other than OPER.

You log off by typing bye in the Command Zone and pressing ENTER. This 
returns Station to OPER security level.

Understanding security levels
Your security level determines which tasks you are permitted to perform. Note, 
however, that even if you are allowed to perform a particular task you may be 
prevented from performing it in certain circumstances.

If you attempt to perform a task that requires a higher security level, the following 
message appears in the Message Zone:

Higher Security Level Required

Your security level appears at the right of the Status Line. The levels are, from 
lowest to highest: View Only, Ack Only, OPER, SUPV, ENGR and MNGR.

Attention
Station may be customized to automatically log you off if you do not use the keyboard for 
a specified time.
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Changing Station’s setup file
Station automatically uses default.stn unless you select another setup file. Use 
this procedure if you want to use a setup file other than default.stn.

To select another Station setup file:
1 Select Station > Connect. 

The Connect dialog box opens.

2 Select the appropriate configuration file from the Recent Connections tab or 
the Other Connections tab.
The Recent Connections tab contains a list of setup files (.stn) most recently 
used. The Other Connections tab lists all your setup files. If your setup file is 
not listed, click the Browse button to navigate the required setup file.

3 Click Connect.
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About Station’s layout
This section describes the single window Station layout. If you are using Multi-
window Station see “About multi-window Station layout” on page 30 for a 
description of the layout.

The current display occupies most of the Station window. The other parts, above 
and below the display, provide you with the tools and controls you use to monitor 
and control your system.

Figure 3 Station’s layout

Part Description
Menubar You select commands from Station’s menus in the same 

way as in other applications.
For example, to call up the Event Summary, select View 
> Events > Event Summary.

Toolbar Clicking a button on the toolbar provides speedy access 
to a frequently required command. For a description of 
each button, see “Using the toolbar” on page 33.

Command Zone You type commands in the Command Zone. See 
“Entering commands in the Command Zone” on 
page 35.

Menus

Status Line

Toolbar

Display

Message Zone

Alarm Line

Command Zone
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About multi-window Station layout
If you are using multi-window Station, the layout depends on how it has been 
configured for your site. For example, if you have a quad-monitor computer in an 
Icon Series Console, the layout might be configured such that:

• Monitor 1 contains a Command window, containing the command zone, 
message, toolbar and menu bar, a Status window containing the Status Line 

• Monitor 2 contains the Alarm Summary 

• Monitor 3 contains trend displays that you call up 

• Monitor 4 contains custom displays

Regardless of how your multi-window Station layout has been configured, the 
operational aspects are similar to a single-window Station. For example, the 
Status Line shows the same information, the Command Zone, menu bar, and 
toolbar operate in the same manner. Where displays appear in the multi-window 
Station depends on how your site has been configured.

Message Zone Station displays explanatory messages in the 
Message Zone. For example, if you try to call up a non-
existent display, something like “The display file xxxx 
was not found” appears in the Message Zone.

Display Each display is a separate “control panel” that you use to 
monitor and control a particular part of your system. For 
more information about displays, see:
• “Using displays” on page 47
• “Understanding display objects” on page 54

Alarm Line Generally, this line displays the most recently 
unacknowledged alarm message. (The Alarm Line may 
be hidden on your system, or it may be configured to 
operate in a special manner.)

Status Line Provides an overview of your system’s status. For 
example, a flashing red box indicates that there is at least 
one unacknowledged alarm. See “The Status Line” on 
page 31.

Part Description
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The Status Line
The Status Line provides an overview of your system’s status. The following 
table describes each box in the Status Line, starting from the left.

Figure 4 Status line for a Flex Station

Figure 5 Status line for a Console Station or Console Extension Station

Figure 6 Status line for a Console Station or Console Extension Station in a console

Box Description
Date and time The current date and time, as set on the server.

Indicates whether there are any alarms, as well as their 
status:
• Blank. There are no alarms.
• Flashing red. There is at least one unacknowledged 

alarm.
• Red (not flashing). There is at least one alarm, but 

they have all been acknowledged.
Click the box to call up the Alarm Summary, which lists 
each alarm.

If the Station status line is not visible, this icon in the 
Windows status bar will indicate an alarm.

Alarm
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Indicates whether there are any system alarms, as well as 
their status, for example, failed communication links 
between the server and other devices (such as channels, 
controllers, and so on):
• Blank. There are no system alarms.
• Flashing cyan. There is at least one unacknowledged 

system alarm.
• Cyan (not flashing). There is at least one system 

alarm, but they have all been acknowledged.
Click the box to call up the System Status display, which 
lists each system alarm.

Indicates whether there are any messages, as well as 
their status:
• Blank. No messages.
• Flashing green. There is at least one unacknowledged 

message.
• Green (not flashing). There is at least one message, 

but they have all been acknowledged.
Click the box to call up the Message Summary, which 
lists each message.

Indicates whether there are any alerts, as well as their 
status:
• Blank. No alerts.
• Flashing white. There is at least one unacknowledged 

alert.
• White (not flashing). There is at least one alert, but 

they have all been acknowledged.
Click the box to call up the Alert Summary, which lists 
each alert.

If the Station status line is not visible, this icon in the 
Windows status bar will indicate there are no alarms in 
the system, but there is an alert.

Server ID The computer name of the server to which the Flex 
Station or Console Station is connected. (In some 
systems, you can connect to more than one server.) 
On a Console Station or Console Extension Station:
• A red LED appears if the server is unavailable.
• A yellow LED appears when the Console Station is 

synchronizing with the server.

Box Description

System

Message

Alert
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Using the toolbar
The buttons in the toolbar provide speedy access to frequently required displays 
and commands. For example, to call up the System Menu you simply click the 
toolbar button.

Console ID The name of the console to which the Station belongs. 
This is visible only on Console Stations and Console 
Extensions Stations that belong to a console.
A yellow LED appears if one or more Console Stations 
or Console Extension Stations in the console is 
unavailable.
Click the box to call up the Console Status display.

Station number The number of the Station you are logged on to. (Most 
systems have more than one Station.) This is visible on 
Flex Stations, Console Stations and Console Extension 
Stations. For a Flex Station the number is in the format 
Stnnn, for example Stn03. For a Console Station or 
Console Extension Station, the number is in the format 
CStnnn-n, for example CStn04-1 for a Console 
Station and Cstn04-2 for a Console Extension Station.

Security level Your security level. See “Understanding security levels” 
on page 27.

Box Description

Button Description
System Menu. Calls up the System Menu, a specialized display that 
provides quick access to the other major displays. See “Calling up a display 
from the System Menu” on page 49.

Alarm Summary. Calls up the Alarm Summary, which provides a one-line 
description of every alarm. See “Responding to alarms” on page 65.

Acknowledge/Silence Alarm. Acknowledges the most recent, or selected, 
alarm.

Associated Display. Calls up the display associated with the object that is 
in alarm, or the selected object.
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Callup Display. Calls up the specified display. To call up a display:
1. Click the button.
2. Type the display’s name/number and press ENTER.

When configuring a system, engineers normally link related displays in a 
“chain” so that you can quickly call up the next/previous display.
Page Down. Calls up the next display in the current chain.
Page Up. Calls up the previous display in the current chain.

Navigate Back.
Navigate Forward
Enable you to move backwards and forwards between displays you have 
previously called. Click the arrow to the right of the Navigate Back and 
Navigate Forward buttons to view a list of displays you have previously 
called.

Reload Page.
Reloads the current display

Trend. Calls up the specified trend display. To call up a trend:
1. Click the button.
2. Type the trend number and press ENTER.

Group. Calls up the specified Group Detail display. To call up a group:
1. Click the button.
2. Type the group number and press ENTER.

Raise. Raises a parameter value.
Lower. Lowers a parameter value.
See “Example scenario—changing the value of a point from a display” on 
page 59.

Enter. Accepts the newly entered value.
Cancel. Cancels the newly entered value, and returns it to its original value.

Enable/Disable. Enables/disables for the associated point. Points are 
typically disabled when performing maintenance tasks to prevent 
misleading alarms being generated.
See “Disabling a point” on page 60.

Button Description
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Entering commands in the Command Zone
When you become familiar with Station, you may find it quicker to enter some 
commands in the Command Zone rather than choosing them from menus, or 
navigating through several displays.

For example, to call up a display called “boilers”:
1 Give focus to the Command Zone.

2 Type boilers and press ENTER.

Detail/Search. Performs either of two tasks, depending on the context:
• If an alarm or object is selected on the current display, clicking the 

button calls up the associated Point Detail display. See “Using Point 
Detail displays” on page 113.

• If nothing is selected on the current display, clicking the button calls up 
the Search display, which you then use to search for system items such as 
points, operators and so on. See “Searching for system items” on 
page 42.

Zoom. Changes the magnification of displays.

Command Commands are typed in the text box. The Command Zone also retains a 
history of previously selected displays. You can return to a display by 
choosing from the list. See “Entering commands in the Command Zone” on 
page 35.

Button Description

Tip
There are several methods you can use to give focus to the Command Zone:
• Press ESC
• Press TAB until the focus moves to the Command Zone (This method does not work in 

the multi-window environment.)
• If no data-entry box has focus, press an alphanumeric key
• Press any of the function keys that require data entry
• Click in the Command Zone.
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For a complete list of Command Zone commands, see “Command reference” on 
page 162.

The Command Zone retains a history of the last 20 different commands that you 
have opened since you logged on. You can re-enter a display quickly by choosing 
its command from the alphabetically arranged list. Note that if you make a typing 
error when entering a command, you can fix the error by selecting it from the list, 
making the correction, then press ENTER.

Resizing the Station window

To resize the Station window if it is maximized (occupies the full screen):
1 Click  (Restore) in the top-right of the window.

2 Move the pointer to the window border or corner.

3 When the pointer changes to a two-headed arrow, drag it to resize the window. 
As you drag, the border moves with the pointer, making the window larger or 
smaller.

To move the Station window:
1 Move the pointer over the title bar at the top of the window.

2 Drag the pointer. As you drag, the window moves with the pointer.

To minimize the Station window, so that it disappears:
1 Click  (Minimize) in the top-right of the window.

The only indication that Station is still available is the Station button on the 
taskbar at the bottom of the screen).

Attention
In the case of a numbered display, you need to type pag before the page number, for 
example: pag301.

Attention
• You only need to read this topic if you can resize or move the Station window. (Station 

may be configured so that it always occupies the full screen or so that its windows 
cannot be moved or resized.)

• If you reduce the size of you Station window or zoom in, certain items on a trend 
display, such as the axes and toolbars, may be hidden so that the plot area is always 
visible. These items are visible again when you resize the Station window or zoom out.
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To restore the Station window to its previous size:
1 Click the Station button on the task bar.

Zooming in and out
You can zoom in and out of the display to make the display area of the Station 
window larger or smaller. 

To resize a display:
1 Use the Zoom control on the toolbar to change the magnification of the 

display.

2 If the Station Window does not show the full display, select View > Show Full 
Page.
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About alarms and other messages
Experion has a control system that generates an appropriate messages, depending 
on how you are expected to respond at prescribed times or whenever there is a 
significant change in your system. The way in which you respond to a message 
depends on its type.

For this message type: Go to:
Alarm. An alarm is generated whenever an abnormal condition occurs. page 65

Event. An event is any significant change in the system, including any 
commands you issue.

page 81

Messages. A message can be generated for many reasons. For example, 
when a point goes into alarm, you may receive an explanatory message in 
addition to the alarm message. In other cases you may be required to 
perform a function before a message can be acknowledged.

page 95

Information Only messages need only be acknowledged. They are then 
removed from the list of messages.

page 95

Confirmation messages will flash until you confirm that they have been 
read.

page 95

Single Signature messages require that you acknowledge the message with 
your logon password. You need the appropriate control or security level to 
respond to this type of message.

page 61

Double Signature messages. Some highly critical actions may require a 
dual signature acknowledgment. Two different individuals, each with the 
appropriate control or security level, must acknowledge the message.

page 61

Alert. An alert is generated to indicate an abnormal condition but the 
priority is not high enough for an alarm to be generated. 

page 105

Attention
Explanatory messages also appear in the Message Zone when, for example, you are 
issuing a command. These messages are informative only, and are not caused by changes 
to your system.
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Using your mouse (or its equivalent)
In most systems, Station computers are fitted with a mouse that allows you to 
select objects on the screen.

You use your mouse to perform the following actions:

• Selecting. Move the pointer over an object and momentarily press the mouse’s 
left button—this action is called clicking.

• Displaying object details. Move the pointer over a display object and rapidly 
press the mouse’s left button two times—this action is called double-clicking.

• Tabbing. When you momentarily click the right mouse button—an action 
called right-clicking—you select the next object defined in the tab sequence. 
(A tab sequence is a list of objects that you can select. In general, objects that 
you need to edit or control are added to the tab sequence so that you can easily 
select them.)
If you hold down SHIFT when tabbing, you select the previous object in the 
Tab sequence.

Using a trackball
You use a trackball in a similar manner to a mouse—for example, rolling the ball 
forwards is equivalent to moving the mouse forwards. The functions of the two 
buttons are identical to those on a mouse.

Attention
If you have a specialized device such as a trackball or a touch screen, you need to read the 
appropriate set of instructions: “Using a trackball” on page 39 or “Using a touch screen” 
on page 40.
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Using a touch screen
The following table describes how to use a touch screen that is configured to 
operate in “click on release” mode.

If you want to use a shortcut menu you need to enable the touch screen so that you 
can perform the touch screen equivalent of a right-click.

To enable a right-click:
1 Click the Elo Touch System icon in the Windows system tray.

2 Select Right mouse button tool.
A mouse graphic appears with the right button “clicked”. The next time you 
touch the screen, a right-click is performed. The touch screen then returns to 
left click mode.

To: Do this:
Move the pointer Slide your finger across the screen. The pointer follows 

the tip of your finger.

Select an object Place your finger over the target or object.

Display an object’s details, for 
example, open a point detail 
display

Quickly tap the object twice.
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Using your keyboard
You can perform all Station operations using your keyboard.

Using shortcut keys
You can quickly access many commands by pressing the appropriate shortcut key. 
For example, if you have a standard computer keyboard (with 12 function keys), 
you can display the Alarm Summary by pressing F3.

To learn about keyboard shortcuts see “Keyboard shortcuts” on page 164.

Use the following table to learn about the keyboard shortcuts for your type of 
keyboard. 

Table 1 Keyboard types

If you have this keyboard: Go to:
page 165

page 167

page 170
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Searching for system items
You search for system items—such as points, operators and Stations—using the 

(Detail/Search) toolbar button.

Using the search display
When you use the Search display, your search is restricted to the selected item 
type.

To use the Search display:
1 Click the  toolbar button to call up the Search display.

2 Select the type of item you are searching for in Search in.

3 Type the item name (or the first part of it) in For and then click the Go button.
If your search finds only one item, its details are displayed.
If your search finds more than one item, they are listed in Search Results 
display. Click an item to see its details.

Searching from the Command Zone
You can search from the Command Zone regardless of what is currently 
displayed; however, the search is not limited to a specific item type.

To search from the Command Zone:
1 Click the Command Zone.

2 Type the item name (or the first part of it) and then click the  toolbar 
button.
If your search finds only one item, its details are displayed.
If your search finds more than one item, they are listed in Search Results 
display. Click an item to see its details.
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Getting help
You can display an online version of this guide by choosing Help > Operator’s 
Guide.

If you have not used online documentation before, click the Help Me! button at 
the top of the guide’s window.
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3Using Station in an Icon Series 
Console

If your site uses the Icon Series Console there are two possible modes that Station 
can use. These modes are single window and multi-window. 

If your site uses single window mode with Flex Stations, then you can be logged 
on to multiple Stations at the same time, displayed on separate monitors. If your 
site has a dual Icon Console, there are two monitors, therefore you can be logged 
on to two Stations at one time. If your site has a quad Icon Console, there are four 
monitors, therefore you can be logged on to four Stations at one time.

If your site uses multi-window mode, then you can be logged on to one Flex 
Station, Console Station, or Console Extension Station with multiple Station 
displays visible simultaneously. These displays can be placed in any of the 
monitors in the Icon Series Console.

In addition to, or in place of the standard keyboard and mouse, your Icon Console 
may have:

• An OEP (Operator Entry Panel) keyboard

• A trackball

• A thumbwheel

• A keypad

The one set of these devices are used to carry out controls in all instances of 
Station.
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Moving around the Icon Console
You use the one set of devices (keyboard, mouse and so on) to control the 
multiple Stations or multi-window Station in your Icon Console.

You give a Station or Station window “focus” by moving the position of the 
pointer from one Station to another using your mouse or trackball and clicking in 
the Station window. As you physically move the mouse or trackball, the pointer 
moves. When you reach the edges of the monitor, the pointer appears in the 
adjoining monitor.

When the required Station Window has focus, you use your devices in the normal 
manner to issue controls.

Using your keypad
The keypad functions as a keyboard with the addition of the operator entry keys.

Using your thumbwheel input module
The thumbwheel input module contains two thumbwheels. You use the 
thumbwheels to raise or lower the value of a selected object.

If your thumbwheel is Use the
Installed on the left-hand side 
of the console

Left (outer) thumbwheel to raise or lower the value of 
the selected object by 10% (default setting). 

Right (inner) thumbwheel to raise or lower the value of 
the selected object.

Installed on the right-hand side 
of the console

Right (outer) thumbwheel to raise or lower the value of 
the selected object by 10% (default setting). 

Left (inner) thumbwheel to raise or lower the value of 
the selected object.
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Station’s displays are, in effect, a set of control panels through which you monitor 
and control your system.
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Understanding system displays
Station includes many system displays, which are categorized as follows:

Display type Description
Detail Provides detailed information about a particular point. 

This information includes current values, scanning, 
history and so on.

Trend Graphically displays changes in values, over time, of 
one or more variables. Trends can be displayed in 
several ways, including lines and barcharts.

Group Displays various types of information about related 
points on a single display.

Summary Displays information, such as alarms and events, in list 
form. You can display more details about an item in the 
list by clicking it.

Status Displays detailed status information about system 
equipment, such as controllers and printers.

Configuration These displays are only used to set up your system. As 
an operator, you may need to look at them, but you will 
probably not be able to change them.
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Calling up a display
You can call up a display using any of the following techniques.

If you need to call up Web pages or files such as Microsoft Word documents, see 
“Calling up a web page or file” on page 52.

Calling up a display from a menu

This example shows how to call up the Event summary:
1 Click the View menu. A list of important system displays appears. (The list 

also includes commands).

2 Move the pointer down to Events. A list of event displays appears.

3 Select Event Summary to see the Event summary display.

Calling up a display from the System Menu
The System Menu is a specialized display that provides quick access to the other 
major displays.

To call up a display from the System Menu:
1 Click (System Menu) on the toolbar to call up the System Menu.

2 Click the button next to the display you want to see.

Calling up a display from the toolbar
The toolbar contains several buttons, such as (System Menu), that quickly 
call up specialized menus or displays.

For details of other buttons that call up displays, see “Using the toolbar” on 
page 33.

Tip
Custom displays are usually listed under a special menu. Ask your supervisor or an 
experienced colleague for the menu’s name, and the purpose of each of the listed displays.
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Calling up a display from the Command Zone
You can call up a display from the Command Zone providing you know its name 
or number. (Experion uses two naming conventions for displays. Some, including 
many system displays, are numbered; whereas others, including most custom 
displays, are named.)

The title and the name/number of the current display are shown at the top of the 
Station window. For example: “Channel Status Summary (65)” is a numbered 
display, whereas “Search (sysSearch) is a named display.

To call up a display whose name is “primary”:
1 Click the Command Zone.

2 Type primary and press ENTER.

To call up a display whose number is “57”:
1 Click the Command Zone.

2 Type pag57 and press ENTER.

Calling up a display with a shortcut key
You can quickly call up important displays, such as the Alarm Summary by 
pressing the appropriate shortcut key. For example, if you have a standard 
computer keyboard, pressing F3 calls up the Alarm Summary.

For a list of shortcut keys, see “Keyboard shortcuts” on page 164.

Calling up a display for another Station in a console
If you use Console Stations or Console Extension Stations in a console, you can 
call up displays for another Station within the same console. This type of display 
callup enables you to call up the current display or the next display. 

Tip
If your system has been configured to use this function then your Console Station or 
Console Extension Station will have a specifically configured keyboard shortcut or button 
to be able to call up displays for another Station.
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Using displays in multi-window mode
If your Station uses multi-window mode, you are able to view multiple Station 
displays at the one time. Depending on how your site has been configured, certain 
parts of your screen area might be reserved for a particular type of display. For 
example, if you have an quad monitor Icon Series Console, the top-right monitor 
might be reserved for trend displays. In this case, whenever you call up a trend 
display, it always appears in the top-right monitor.

In some cases, your Station might be configured with “round robin” behavior. For 
example, if your Station can have four displays visible at the same time, when 
you call up a fifth display, the oldest of the four displays is closed and the fifth 
display replaces the oldest display.

Regardless of how your site has been configured, you use the same methods of 
calling up displays as is used for single mode Station.
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Calling up a web page or file
In addition to calling up displays, you may need to call up Web pages and other 
files, such as Microsoft Word documents. Such pages and files typically contain 
operating procedures.

To call up a HTML file called, “c:\procedures\proc7.htm”:
1 Click the Command Zone.

2 Type file://c:\procedures\proc7.htm and press ENTER.

The following table shows how to call up various types of file/page.

Attention
SafeBrowse is the Station feature that allows you to call up Web pages and files. It may 
have been configured so that you can only call up authorized Web pages and files.

To call up a: Type:
File file://c:\procedures\proc7.htm

where c:\procedures\proc7.htm is the full name of a 
file.

Web page http://www.honeywell.com

where www.honeywell.com is the address of a Web site.

FTP Site ftp://ftp.xyz.com

where ftp.xyz.com is the address of a FTP site.
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Printing Station information
At times you may want to print a “snapshot” of a display, or whatever else is 
shown in Station. In the case of a display, the shapshot shows the display’s values 
and statuses at the moment you issue the print command.

To print Station details:
1 Select Action > Print. A message appears, indicating that the details are 

being printed.

Notes:
• The Status and Alarm Lines are printed, but not the Message Zone.

• If you print a Web page, only the visible portion of the page is printed.
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Understanding display objects
As you move around the displays, you will notice that they contain discrete items 
such as buttons, check boxes and indicators—these are called display objects. The 
following table describes the main types of display object.

Display object Description
Alphanumeric. There are two types of alphanumeric:
• Read-only, which displays a numeric value (such as 

boiler temperature) or text (a message or status).
• Data-entry, which you can edit. For example, if the 

alphanumeric represents a point’s SP (setpoint)— 
such as boiler temperature—changing its value will 
raise/lower the boiler’s temperature.

Button. When you click a button, Experion performs a 
specified task such as turning off a motor or calling up 
another display.

Chart. Charts display real-time or historical information 
in a graphical manner. Charts can simultaneously display 
several types of information, such as the temperature and 
pressure of a boiler. Charts can also display information 
in the most appropriate form, such as lines or bars.
If a chart is larger than its “window”, you can use the 
scrollbars to move around the chart. For example, if the 
chart is very long, moving the horizontal scroll box to 
the left or right moves the chart to the left or right.

Check box. When you click a check box, you select or 
clear an option. An “x” in the check box indicates that 
the option is selected.

Indicator. An indicator gives a visual indication of a 
value, relative to its minimum and maximum values.

List. Contains a list of options. You display the list by 
clicking the  button, and then select the appropriate 
option by clicking it.
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This chapter describes points and various methods you can use to control points.
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About points
A point is a collection of information about a particular part of your system. For 
example, a point representing a motor would include:

• An ID, also known as a tag name, which uniquely identifies the motor.

• A description.

• A full item name. The full item name indicates a point’s location within the 
asset model, for example, /assets/Plant/Filtration/Tank/FlowMeter 
indicates that the point named Flowmeter is assigned to the asset named Tank 
which is itself assigned to the assets name Filtration and Plant which are 
interconnected in a hierarchy.

• The current state (off or on).

• The desired state. This is applicable if you are allowed to control the point. 
For example, if current state of the motor is “On” you can change the real state 
of the motor to “Off” using the display.

About point parameters
Each item of information about a point is called a parameter. The main 
parameters store:

• The current value or state of the point (sometimes referred to as Process 
Variable or PV).

• The desired value or state of the point (sometimes referred to as Set Point or 
SP).

• The output value of the point (sometimes referred to as OP).

• The control state of the point, that is, whether the point is being automatically 
controlled or manually controlled (sometimes referred to as Mode or MD).

Not all points will have all of these parameters. 

About assets
Assets can represent entities such as fixed plant equipment, materials, and 
buildings. The Asset Model provides a hierarchical structure that resembles your 
organization.

The points in your system belong to assets. For example, you might have an asset 
that represents a furnace in your plant. All the points associated with the physical 
furnace (analog points measuring the temperature, status points controlling valves 
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or pumps associated with the furnace) might belong to the asset that represents 
the furnace.

The part of the system for which you are responsible can be controlled by 
assigned assets to you or the Station you are using. In addition, where assets have 
been assigned to you, the tasks that you can perform can also be restricted. For 
example, you may have View access to an asset in your system. In this case, you 
can only view items associated with the asset, you cannot make any changes, such 
as acknowledging alarms or changing a point parameter.

About alarm groups
The points in your system can be grouped together in an alarm group. The points 
do not necessarily have to relate to one another as they do with assets. For 
example, you may have an alarm group which groups together all points that 
control the pumps in your plant.

Alarm groups provide an alternative view of the points and their alarms in the 
Alarm Summary.

Alarm groups have a Detail display which provides alarm accounts for the points 
within the alarm group.
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Controlling points
You control your system by controlling points. For example, to turn off a motor, 
you would set the appropriate parameter of the associated point to “Off”.

In some cases you may be required to provide either a single or a double 
electronic signature before making changes to control points. See “About 
Electronic Signatures” on page 61 and “Controlling points requiring Electronic 
Signatures” on page 62.

You can control a point from:

• A point detail display

• A faceplate, if one has been configured for the point

• A custom display

Example scenario—changing the value of a point from the detail display
You want to switch off a fan for maintenance purposes. The point that controls the 
fan you want to switch off is called fan_unit2 and it has the following 
parameters:

• PV, which shows the current value of the point.

• OP, which is the parameter you use to control the point.

• MD, which shows the control mode of the point.

Attention
The amount of control you have depends on several factors, including your security level, 
and the way in which a point has been configured. There are also several ways of 
controlling a point. Consequently, you should ask your supervisor or an experienced 
colleague before you attempt to control any point.

To control a point from Do this
A point detail display double-click an associated display object—this calls up the 

Point Detail display for that point. You can then change 
parameter values.

A faceplate Click an associated display object, such as an alphanumeric. 
The faceplate pops up. You can then change parameter 
values.

A custom display Select an editable associated display object, such as an 
alphanumeric.
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Solution
1 Double-click an associated display object to call up the Point Detail display 

for fan_unit2.

2 If control mode (MD) of the point is set to AUTO, change it to MAN.

3 Change OP to Off.

If the fan has failed, you can disable the related point by clearing the Scanning 
and Control Enabled check box to prevent misleading error messages being 
generated.

Example scenario—changing the value of a point from a display
You want to change the temperature of a boiler. The point that controls the boiler 
temperature is called boiler1_temp. The point has the following parameters:

• PV, which shows the current temperature

• SP, which you use to change the desired temperature

You are currently viewing a display which graphically shows the boiler as well as 
labeled alphanumeric display objects for the parameters.

Solution
1 Select the alphanumeric that shows the SP. (The object is editable if the value 

appears in “reverse video” when you select it.)
Information about the point, including its ID, appears in the Message Zone.

2 Change the value by either:

- Typing the new value and pressing ENTER.

- Clicking toolbar buttons. Clicking (Raise) or (Lower). Each time 
you click the button the value increases/decreases by a small amount.

Example scenario—changing the value of a point from a faceplate
You want to turn on the lights in the south west corner of level one in your 
building. The point that controls these lights is called Level1SWLights. The point 
has the following parameters:

• Value, which shows the current status of the point, that is whether the lights 
are on or off.

• Mode, which shows the control mode of the point.

A faceplate has been created for this point.
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Solution
1 Click an associated display object to call up the faceplate for 

Level1SWLights.

2 Change Mode to Manual.

3 Change Value to On.

Disabling a point
You typically need to disable a point if the associated device is being serviced or 
repaired—this prevents misleading alarms being generated. (When you disable a 
point, Experion stops gathering information about that point.)

To disable a point:
1 Select an editable display object associated with the point—for example, an 

alphanumeric that shows the PV. (The object is editable if the value appears in 
“reverse video” when you select it.)
Information about the point, including its ID, appears in the Message Zone.

2 Click (Enable/Disable).

The point’s parameters turn gray to indicate that the point is disabled.

To enable a disabled point:
1 Select an editable display object associated with the point—for example, an 

alphanumeric that shows the PV. (The object is editable if the value appears in 
“reverse video” when you select it.)
Information about the point, including its ID, appears in the Message Zone.

2 Click (Enable/Disable).

Attention
Not all point types can be disabled in this manner.
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About Electronic Signatures
As a security measure, certain types of messages and control point changes may 
require either a single or double signature confirmation.

When an electronic signature is required, an Electronic Signature dialog box is 
displayed. You may, in some cases, need to select a reason for the response or 
action from a predefined list. Optionally, you may also add a comment in the 
dialog box. Note however, that once you click the Sign button, the reason and 
comment cannot be modified or deleted.

For some highly critical actions, two electronic signatures may be needed. In the 
case of a double signature requirement, the Electronic Signature dialog box 
displays two tabs — one for the Primary signature, and the other for the 
Secondary signature. The minimum control (or security level) and the asset 
assignment required by either signer is displayed on their respective tabs.

The secondary signature must be different from the primary signature and must 
be made by an individual with the appropriate security level.

See “Controlling points requiring Electronic Signatures” on page 62 and 
“Responding to messages” on page 95 for additional information.

Figure 7 Electronic Signatures - dual signature requirement
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Controlling points requiring Electronic Signatures
Certain point control operations may require either single or double signatures 
before they can be made. 

If a single signature is needed, you must have the appropriate control level to 
perform the task. A control level can be any number from 0 to 255. Only an 
operator who has a control level that is equal to or higher than the point's control 
level can control that point. When you attempt to make a change to a point, the 
minimum control or security level required is shown in the Electronic Signature 
dialog box. If a secondary signer is also required, the dialog box will contain two 
tabs, one for each of the signers. The required security level of the second signer 
is shown in the Secondary signature tab.

To sign with a single electronic signature:
1 When the Electronic Signature dialog box is displayed, select a predefined 

reason from the Reasons list (if applicable).

2 Type your user name if required.

3 Type your password.

4 Select your domain, if required.

5 Type any additional information under Comments.

6 Click OK.
A confirmation is sent to the controller and the change takes place. An event is 
generated recording your name and other information about the action, such 
as date and time.

To sign with a double electronic signature:
1 When the Electronic Signature dialog box is displayed, select a predefined 

reason from the Reasons list (if applicable) in the Primary signature tab.

2 Type your user name, if required.

3 Type your password.

4 Select your domain, if required.

5 Type any additional information under Comments.

6 Click Sign.
Your signature is locked in and cannot be changed.

7 Click the Secondary signature tab.
The secondary signer must have a different user name from the primary signer 
and must have the a security level equal to or higher than level displayed in 
the Secondary signature tab.
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8 The secondary signer types their user name, domain and password.

9 Any additional information, if required, is added in Comments. 

10 Click OK.
A confirmation is sent to the controller the change is made. Events are 
generated recording the names of the signers together with other details.
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6Responding to alarms

An alarm is generated whenever an abnormal condition occurs. Alarms are 
typically associated with points—for example, the value of an analog point 
representing a temperature sensor, may be above or below the acceptable range. 
These types of alarms are known as “process” alarms because they are associated 
with the process you are monitoring and are display only on the Alarm Summary.

Alarms may also be generated when any important event occurs, such as a 
communications failure. These types of alarms are known as “system” alarms 
because they are associated with components that form your system. These 
alarms are displayed on the System Status display. 

Tip
The Alarm box in the Status Line flashes red if there are any unacknowledged alarms.
The System box in the Status Line flashes cyan if there are any unacknowledged system 
alarms.
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The Alarm Summary
Alarms are listed on the Alarm Summary, which provides a one-line description 
of an alarm.

If a repeat alarm occurs, the repeat is not added as another entry in the summary. 
Instead, the alarm details of the original alarm are updated to show the details of 
the latest occurrence of the alarm. The number of occurrences of the alarm and 
the time of the original alarm are shown in the Details pane of the alarm. An 
alarm is considered to be a repeat alarm if the source, condition, parameter, are 
the same.

To call up the Alarm Summary:
1 Click the (Alarm Summary) toolbar button. (Alternatively, choose 

View > Alarms from the menu).

The following table describes the default alarm line items, starting from the left.

When a function is disabled, the original icon shape is retained, but the symbol 
changes to a minus sign and its color changes to gray.

Figure 8 Alarm Summary

Attention
The alarm colors described below are the default alarm colors. Your system may use 
custom alarm colors.
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Alarm line item Description Disabled
Red and flashing: the alarm is urgent priority, 
unacknowledged and the cause of the alarm still exists.
Red and not flashing: the alarm is urgent priority, 
acknowledged and the cause of the alarm still exists.
Inverse color and flashing: the alarm is urgent priority, 
unacknowledged and the cause that generated the alarm 
no longer exists.

Yellow and flashing: the alarm is high priority, 
unacknowledged and the cause of the alarm still exists.
Yellow and not flashing: the alarm is high priority, 
acknowledged and the cause of the alarm still exists.
Inverse color and flashing: the alarm is high priority, 
unacknowledged and the cause that generated the alarm 
no longer exists.

Cyan and flashing: the alarm is low priority, 
unacknowledged and the cause of the alarm still exists.
Cyan and not flashing: the alarm is low priority, 
acknowledged and the cause of the alarm still exists.
Inverse color and flashing: the alarm is low priority, 
unacknowledged and the cause that generated the alarm 
no longer exists.

Questionable alarm. The state of an existing alarm is 
unknown because communications with the source of the 
alarm have been lost.

Time The time and date at which the alarm was received.

Location The tag name of the asset to which the point or device 
belongs.

Source The point or device that caused the alarm.
If the point ID is too long to be fully displayed in the 
alarm summary, it is truncated. To see the full name place 
the mouse pointer over the partial point ID to display the 
full point ID.

Condition The alarm condition.
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Priority The priority of the alarm. The prefix letter indicates the 
general priority:
• Urgent
• High
• Low
If a number follows the letter, it represents the relative 
priority within the general priority. For example, Urgent 
alarms can vary from U15 (most urgent) to U00 (least 
urgent).

Description A description of the alarm.
If the description is too long to be fully displayed in the 
alarm summary, it is truncated. To see the full description 
place the mouse pointer over the partial description to 
display the full description.

Trip Value The value that triggered the alarm.

Live Value The current value. This value is continually updated.

Units The unit that the value represents, for example ml/s.

Alarm line item Description Disabled
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The System Status display
The System Status display is similar to the Alarm Summary, however the System 
Status display shows system alarms for system and network components only. 
Examples of system alarms are:

• Communications failures

• Station failures

• Operator logon failures

• Printer failures

(System alarms can also be shown in the Alarm Summary, however the Alarm 
Summary can be configured so that system alarms are filtered out of the Alarm 
Summary.)

The alarm line items on the System Status display are the same as the alarm line 
items on the Alarm Summary. For a description of the alarm line items see “The 
Alarm Summary” on page 66.

Alarm acknowledgement on the System Status display is the same as alarm 
acknowledgement on the Alarm Summary. See “Acknowledging alarms” on 
page 78.

Filtering and sorting the System Status display is the same as filtering and sorting 
the Alarm Summary. See “Changing what is shown in the Alarm Summary and 
the System Status display” on page 72.

If your system incorporates System Management software, FTE, or TPS, you can 
navigate to related displays from the System Status display. The Location pane on 
the System Status display includes the following links:

• System Management—if you click the link, the System Management display 
opens.

• FTE Status—if you click the link, an FTE Status display opens in Station.

• TPS System Status—if you click the link, Native Window opens.

To call up the System Status display:
1 Choose View > System Alarms.
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The System Status display Location pane
The Location pane on the System Status displays has two hierarchical trees; one 
shows the network components that have been added to the tree, the other shows 
all of the Experion related components such as servers, Stations, channels and 
controllers.

You can expand and collapse the trees as required to navigate to the component to 
check its status or to view alarms associated with the component.

When one of the components in the tree goes in to alarm, an icon appears next to 
the component name that is in alarm. This alarm is also shown at the root object 
in the tree.

Components such as servers and Stations, in both the System Components tree 
and the Network tree, show a status icon which indicates their current state.

Figure 9 System Status display

Tip
If you move your mouse over the status icon, a tooltip describing the current state 
appears.
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The System Status display Status pane
The Status pane shows more information about the status of the item you have 
selected in the Location pane. For example:

• Performance information such as CPU usage and disk space

• Firmware versions

• Redundancy status such as link status and last synchronization time

• Channel statistics

The Status pane is empty if you do not have an item selected in the Location pane. 

To show the Status pane:
• Click the Show Status Pane icon .
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Changing what is shown in the Alarm Summary and the 
System Status display

By default, the Alarm Summary and the System Status display show all alarms, 
with the newest alarm at the top. You can change this by applying filters and 
sorting the summary.

Filtering allows you to show alarms that match the filter criteria and hide alarms 
that do not match the filter criteria. For example, you can filter to show alarms:

• Of a particular priority only 

• For a particular asset only on the Alarm Summary

• For a particular piece of equipment on the System Status display

You can also filter by most columns in the summary. 

Sorting allows you to set the order in which alarms appear. The sort order can be 
ascending or descending. For example, you can sort alarms by date and time, in 
ascending order. This means that alarms are listed in order of ascending date and 
time, that is, the oldest alarm is listed at the top of the summary.

You can apply more than one filter at a time and you can also filter and sort at the 
same time. When the Alarm Summary is filtered or sorted, the column by which 
you are filtering or sorting is highlighted.

Using the Location pane
The Location pane on the Alarm Summary provides a tree view of assets to which 
you or the Station you are using have been assigned while the Location pane on 
the System Status display provides tree views of your network components and 
system components. You can use the Location pane to filter the Alarm Summary 
and the System Status display to show alarms for a:

• Particular asset 

• An alarm group

• A particular piece of equipment

Attention
Depending on your security privileges, you may not be able to filter and sort the Alarm 
Summary or the System Status display. The options that are not available to you are 
disabled and appear “grayed out”.
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Using the Location pane, you can easily see the priority of the highest priority 
alarm for each item and the number of alarms for each item in the trees.

To show the Location pane use either method:
• Click the Show Location Pane icon .

• Click the Location list  and click the Push Pin to dock the Location 
pane .

To hide the Location pane use either method:
• Click the Hide Location Pane icon .

• Click the Close icon in the Location Pane .

To filter using the location pane:
1 Show the location pane if it is hidden.

2 Expand the asset tree to locate the item by which you want to filter.

3 Click the required item. 
The alarms are filtered to show any alarms for this item. 

Figure 10 Alarm Summary location pane
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Using column filtering

To filter the Alarm Summary:
1 Call up the Alarm Summary display.

2 Click the column heading you want to filter by.

3 Select the filter you want to apply.

Example scenario—filtering
You want to filter the Alarm Summary so that you see unacknowledged alarms of 
high priority only.

Solution
1 Call up the Alarm Summary display.

2 Click the Priority column and select High.

3 Click the Alarm State column and select Unacknowledged.

The Alarm Summary changes to list unacknowledged alarms of high priority 
only.

To sort the Alarm Summary
1 Call up the Alarm Summary display.

Figure 11 Filtering the Alarm Summary
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2 Click the column heading you want to sort by.

3 Select the sort order.

Example scenario—sorting
You want to sort the Alarm Summary so that alarms are sorted in ascending order 
by value.

Solution
1 Call up the Alarm Summary display.

2 Click the Value column.

3 Select Sort Ascending.

The Alarm Summary changes to list alarms in ascending order according to the 
value.

To remove filtering:
• Click Clear all Filters.

To revert to the default setting (removing all filtering and sort in descending time 
order), load the All Alarms view (see “Using views” on page 75 for details).

Using views
You can change how information is displayed in the Alarm Summary by applying 
a different “view”. A view contains the information about filtering and sorting, 
which alarm line items are shown, the order they are shown in and the space 
provided for each item. Figure 8 on page 66 shows the default Alarm Summary.

There are several predefined views. These are:

• Unacknowledged alarms; shows only unacknowledged alarms

• Urgent and high alarms; shows alarms of urgent and high priority only 

• Urgent alarms; shows alarms of urgent priority only 

There may be other views that have been configured for your system. Ask your 
supervisor or an experienced colleague about other views and the information 
they display in the Alarm Summary.

To apply a view:
1 Click the view list.

2 Select the view from the list.
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Using the details pane
The Details pane shows the details of the currently selected alarm. If no alarm is 
selected, the details pane is empty.

If the selected alarm is for a point, the details pane also provides links to the point 
detail display and associated display.

To show or hide the Details pane:
• Click the Details pane icon .

Navigating the Alarm Summary
There are several ways to scroll the list of alarms on the Alarm Summary. You 
can:

• Use your mouse and click on the scroll bar

• Use your mouse wheel (if your mouse has one)

• Use the Up and Down arrow keys on your keyboard

• Press the PAGE UP and PAGE DOWN keys to scroll a page at a time

• Press the HOME key to go to the first alarm in the summary

• Press the END key to go to the last alarm in the summary

Figure 12 Alarm Summary view list
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If you want to use your keyboard keys or mouse wheel to scroll the Alarm 
Summary, you need click your mouse in the summary grid to give it focus.

Pausing the Alarm Summary
You can pause the Alarm Summary to make it easier to read if alarms are 
occurring in rapid succession. When the Alarm Summary is paused no new 
alarms are added to the summary, however you can still acknowledge alarms and 
filter and sort the summary. Alarms that are acknowledged or returned to normal 
while the summary is paused are shown with a strikethrough.

To pause the Alarm Summary:
• On the Alarm Summary display click Pause.
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Acknowledging alarms
In most systems, Station produces an “alarm tone” when a new alarm occurs. 
(Your system may be configured not to do this.)

There are several ways of silencing or acknowledging alarms:

To: Do this:
Silence the tone Either:

• Click the (Alarm Acknowledge) toolbar button.
• Press the appropriate key—see “Keyboard shortcuts” 

on page 164.

Acknowledge a particular 
alarm on the Alarm Summary

Either:
• Select the alarm and click the (Alarm 

Acknowledge) toolbar button.
• Right-click the alarm then select Acknowledge.

Acknowledge all alarms 
currently visible on the Alarm 
Summary

Click the Acknowledge Page button on the display.
Note that if there are any more unacknowledged alarms 
in the list not currently visible, you first have to display 
them by scrolling the Alarm Summary before clicking 
the Acknowledge Page button again.
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Adding comments to an alarm
If required, you can add comments to alarms in the Alarm Summary. For 
example, you might need to keep a record of your actions in response to an alarm.

Considerations
• If you are operating a Console Station, you can only add comments to an 

alarm when the Experion server is available.

To add a comment to an alarm:
1 Select the alarm to which you want to add a comment.

2 If the Details Pane is not visible, click the Show Details Pane button.

3 Click the Comments tab.
Any existing comments that are added to the alarm are displayed.

4 Type in your comment and click Save Comments.
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Viewing an alarm video clip 
If your Experion has the Honeywell Digital Video Manager installed as part of the 
system, you will be able to view any video clip that may be linked with an alarm 
or event. 

A video icon in the first column of the Alarm Summary indicates that a video clip 
is linked to the alarm.

The video clip associated with the alarm will be displayed in a popup window.

 

To: Do this:
View the video clip Either:

• Double-click the video clip icon associated with 
the alarm listed in the summary.

• Select the alarm in the Alarm Summary that contains 
the video clip, then click the Associated Video link 
on the Details pane.

• Right click the alarm and select Associated Video 
from the menu.
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An event is any significant change in the system, and includes alarms and 
operator actions.

To call up the events display:
1 Choose View > Events > Event Summary to see the list of events from the 

local server only. (Alternatively, click Events on the System Menu.)
Events are listed in chronological order, starting with the most recent event. 
The display is automatically updated, which means that each new event 
appears at the top of the list.

Figure 13 Events Summary 
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2 If you want stop new events from being added to the display—this makes it 
easier to read if events are occurring in rapid succession—change the Date & 
Time filters from All Recent Events - Live to Today (snapshot). For details 
on using filters, see “Changing what is shown in the Event Summary” on 
page 84.

If the point ID or Description has been truncated, move your mouse pointer over 
the point ID or description to display the full point ID or description.
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Journaled events
Distributing all journaled events would need significant bandwidth, so most 
events are only recorded on the server where the point is defined. The exceptions 
are Acknowledgement events and Point Value Change events, which are recorded 
on both the server where they occurred and on the data owner.

This means that the event archive on each server includes all events for its local 
points, and Acknowledgement events and Point Value Change events that 
occurred on the local server and affect remote points.

To view events for a remote server
• Configure and Alarm and Event DSA report that includes events from the 

remote server. (For more information about configuring this report, see 
“Alarm and Event DSA reports” in the Server and Client Configuration 
Guide.)

• Use Station to log on to the remote server and view the Event Summary 
display.

• If sufficient bandwidth is available an OBDC-based report, using the 
Experion OBDC Driver, can be constructed to generate a consolidated event 
report from multiple servers. The OBDC Driver is included with the Experion 
Open Data Access option.
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Changing what is shown in the Event Summary

By default, the Event Summary shows a “live” summary of events. That is, 
current events in the system database, with the newest events at the top.

Using views
You can change how information displayed in the Event Summary by applying a 
different “view”. A view contains the information about filtering and sorting, 
which event line items are shown, the order they are shown in and the space 
provided for each item.

There are three predefined views. These are:

• (all recent events with live updates)—(default view) shows events as they 
are occurring.
For performance reasons there is limited filtering capabilities in the default 
view, and you cannot sort the default view.

• (all today’s events snapshot)—shows all events that occurred today up until 
the view was applied.

• (all recent access events with live updates)—shows all access-related events 
as they are occurring.

There may be other views that have been configured for your system. Ask your 
supervisor or an experienced colleague about other views and what information 
they display in the Events Summary.

Filtering

Considerations
• When viewing the live events from the temporary event file (all recent events 

with live updates) you can only filter on the Location, Priority and Category 
columns. All other filter menus are disabled. If you want to filter on the other 
columns you need to change the Date & Time filter to something other than 
(all recent events - live).

Attention
Depending on your security privileges, you may not be able to filter and sort the Event 
Summary. The options that are not available to you are disabled and appear “grayed out”.
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Filtering the Event Summary allows you to show events that match the filter 
criteria and hide events that do not match the filter criteria. For example, you can 
filter the Event Summary to show events that occurred on a particular day, or you 
can filter the Event Summary to show events related to a particular asset only.

You can apply more than one filter at a time and you can also filter and sort at the 
same time. When the Event Summary is filtered or sorted, the column by which 
you are filtering or sorting is highlighted.

You can change the Event Summary to show all events for the current day and for 
each of the last seven days using the Date & Time filter. You can also do a custom 
time based filter.

Sorting
Sorting allows you to set the order in which events appear in the summary. The 
sort order can be ascending or descending. For example, you can sort events by 
date and time, in ascending order. This means that events are listed in order of 
ascending date and time, that is, the oldest event is listed at the top of the 
summary.

To filter the Event Summary:
1 Call up the Event Summary display.

2 Click the column heading you want to filter by.

3 Select the filter you want to apply.

Example scenario
You want to filter the Event Summary so that you see events that occurred 
yesterday.

Solution
1 Call up the Event Summary display.

2 Click the Date column and select Yesterday. The summary changes to show 
all events that occurred yesterday.

The Event Summary changes to show events that occurred yesterday only.

Considerations
• You cannot sort the “live” Event Summary display.
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To sort the Event Summary
1 Call up the Event Summary display.

2 Click the column heading you want to sort by.
Note that you can only sort by Date & Time and Source.

3 Select the sort order.

Example scenario
You want to sort the Events Summary so that events are listed in ascending order 
according to point ID (0-9, A-Z).

Solution
1 Call up the Event Summary display.

2 Click the Source column.

3 Select Sort Ascending.

The Event Summary changes to list events in ascending order according to the 
point ID.

To remove filtering and sorting:
• Click Clear All Filters.
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Adding comments to an event
If required, you can add comments to events in the Event Summary. For example, 
you might need to keep a record of your actions in response to an event.

To add a comment to an event:
1 Select the event to which you want to add a comment.

2 If the Details Pane is not visible, click the Show Details Pane button.

3 Click the Comments tab.
Any existing comments that are added to the event are displayed.

4 Type in your comment and click Save Comments.
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Viewing an event video clip 
If your Experion has the Honeywell Digital Video Manager installed as part of the 
system, you will be able to view any video clip that may be linked with an alarm 
or event. 

A video icon in the first column of the Event Summary indicates that a video clip 
is linked to the event.

The video clip associated with the event will be displayed in a popup window.

To: Do this:
View the video clip Either:

• Double-click the video clip icon associated with 
the event in the summary list.

• Select the event in the Event Summary that contains 
the video clip, then click the Associated Video link 
on the Event Summary display.

• Right-click the event and select Associated Video 
from the menu.
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Adding an operator recorded event
If you notice an event (such as a safety issue) that is not recorded by the system, 
but that you want included in the Event Summary, Experion allows you to 
manually record that event into the system. Information, such as your user 
identification, date and time, and event category are automatically stored with the 
newly created event.

For ease in filtering, your comments are generated as a special type of operator-
added event that can be selected as a sort criteria when events are displayed.

To: Do this:
Manually add an event to the 
Event Summary

Either:
• Click the Generate Event button on the 

toolbar, then type the comment into the message 
zone.

• Click the Generate Event button on the Event 
Summary display, then type your comment into the 
message zone.
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Using Event Archiving
Event Archiving periodically captures events from the event journal and places 
them into an event database, where they can be used for reporting and diagnostic 
purposes.

Depending on how your system is set up, events are automatically archived at 
specified intervals, or an alarm is generated to alert you of the need to archive.

Experion provides a playback facility, so that you can run reports on events that 
have been restored from archives.

As a security measure, you can use the Experion tampering alert feature to raise 
an alarm if any event record is changed or altered in any way after it is captured. 

To call up the Event Archiving Operations display:
1 Select View > Events > Event Archiving.

Figure 14 Event Archiving Status Display
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2 You can now:

a. Archive the events by clicking the Archive Now button—see “Archiving 
events” on page 92.

b. Check for tampering of event records—see “Checking event records for 
tampering” on page 94.

c. Restore archived events by clicking the Restore button—see “Restoring 
archived events” on page 93.

d. Remove restored archives by clicking the Remove button. The Remove 
button appears when you have restored archives.

e. View the status of events collection and archiving.

Event collection and archive status
The Event Archiving Operations display shows the current event collection and 
archiving status, as described in the following table.

The following table describes each possible archive status.

Status Description
Event Archiving status Shows the current status of events collection and 

archiving. For a description of each status see the table 
below.

Current event rate Hourly average calculated on the previous 24 hours. Is 
updated every hour.

Last archived The last date and time that an archive ran.

Next archive scheduled for The date and time of the next schedule archive. 
Calculated using the last archive date and time and the 
configured schedule.

Archive status Description
OK Event Archiving is working normally.

Overload Events are occurring so frequently that Event Archiving 
is not able to capture them in a timely way. If you see 
this status, refer the problem to your supervisor.

Failed Events collection has failed. 

Full Disk There is not enough disk space to continue events 
collection. Events collection is stopped until there is 
sufficient disk space available.
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Archiving events
Use the following procedure if:

• Your system is not configured to automatically archive events

• You want to archive events before the next scheduled archive

Considerations
• You cannot archive events to tape from Station on a client computer.

To archive events to tape:
1 Click the Archive Now button.

2 Type Y (for “yes”) at the confirmation prompt.

3 Write the suggested label on the tape.

4 Insert the tape into the tape drive and press ENTER. 
This starts Windows Backup, which then saves the events to tape. (Windows 
Backup is a specialized backup utility.)

Considerations
• You can archive events to FileSystem, which may be a folder on the server 

disk itself or on an available network file server.

• When archiving events to a FileSystem use a UNC path rather than mapping a 
drive to your local computer. For example, use \\myserver\archive instead 
of f:\.

To archive events to FileSystem:
1 Click the Archive Now button.

2 Type Y (for “yes”) at the confirmation prompt.

Copy Mode This is only applicable to a redundant system after 
recovery from failure. Event Archiving is disabled while 
the primary extended events database is being copied 
off-line to the backup server. 

Archive status Description
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Restoring archived events
Occasionally, you may need to restore archived events so that you can access 
them. 

The procedure you use to restore archived events depends on how the events were 
archived. If events were archived:

• To tape, use the procedure “To restore archived events from tape:” on page 93. 

• To the file system, use the procedure, “To restore archived events from 
FileSystem:” on page 94.

Considerations
• You cannot restore archives from tape using a Station on a client computer. If 

you are restoring archives from tape you must use Station on the server 
computer.

To restore archived events from tape:
1 Click the Restore button.

2 Type Y (for “yes”) at the confirmation prompt. This starts Windows Backup.

3 In Backup window, click the Restore and Manage Media tab.

4 Expand the tree view of the tape drive device you are restoring from.

5 Select the check box that corresponds to the set you want to restore.

6 Click the Start Restore button.

Figure 15 Restoring events from tape
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7 Confirm your selection.

8 When the restore is complete, click the Close button and exit from Backup.

Considerations
• You can restore archived events from FileSystem from a Station running on 

either the server computer or a client computer.

• When restoring archives from FileSystem, use a UNC path rather than 
mapping a drive to your local computer. For example, use \\myserver\
archive instead of f:\.

To restore archived events from FileSystem:
1 Click the Restore button. 

2 Type Y (for “yes”) at the confirmation prompt. 
The Restore dialog box opens.

3 Select the required .dat file.

4 Click Open.

Checking event records for tampering
Information about events is stored in your database in an encrypted format. As a 
security measure, Experion can detect if any changes have been attempted or 
made to this data that is not a part of the system’s normal operation. Experion can 
be set up to automatically check all events in the database before they are 
archived. Alternatively, if you have the appropriate security level, you can also 
use the Check for Tampering button on the Event Archiving Operations display 
to check the entire event database for tampering on an on-demand basis. In either 
case, if tampering is detected, an alarm is raised.

If you use the Check for Tampering button to verify that the system’s electronic 
records are secure, you are prompted with a message alerting you that this could 
be a time-consuming process, depending on the size of your databases.
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Messages are generated for many reasons. For example, when a point goes into 
alarm, you may receive an explanatory message in addition to the alarm. Other 
types of messages may also give you a set of procedures you are to perform, or 
list some actions you must take before the message can be acknowledged.

There are four types of messages:

• Informational—appear in the summary with an “i” icon. 
When you acknowledge an informational message, it is removed from the 
summary.

• Confirmable—appear in the summary with a “c” icon. 
When you acknowledge a flashing confirmable message it changes to a static 
state. When confirmed, the message is removed from the summary.

• Single signature—appear in the summary with a icon. 
To acknowledge this type of message, you must provide your user name, 
domain and password in the Electronic Signature dialog box that appears 
when you select the message. You can also add comments regarding the cause 
of the alarm. See “About Electronic Signatures” on page 61.

• Double signature—appear in the summary with a icon. 
To acknowledge this type of message, you and another authorized individual 
must provide your user names, domains and passwords in the Electronic 
Signature dialog box that appears when you select the message. Either or both 
signers can add comments regarding the cause of the alarm. See “About 
Electronic Signatures” on page 61.

Attention
The Message box in the Status Line flashes green if there are any unacknowledged 
messages.
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To call up the Message Summary, and acknowledge new messages:
1 Choose View > Message Summary.

Figure 16 Message Summary
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Changing what is shown in the Message Summary

By default, the Message Summary shows all messages, with the newest message 
at the top. You can change the Message Summary by applying views, filters and 
sorting the summary.

Using views
A view contains the information about filtering and sorting, which message line 
items are shown, the order they are shown in and the space provided for each 
item. 

The following views are predefined:

• (all messages)—shows all messages

• (confirmable messages)—shows confirmable messages only

• (informational messages)—shows informational messages only

Your system may be set up with site-specific views. Ask your supervisor or an 
experienced colleague about other views and what information they display in the 
Message Summary.

To apply a view:
1 Click the view list

2 Select the view from the list

Filtering and sorting the Message Summary
Filtering the Message Summary allows you to show messages that match the 
filter criteria and hide messages that do not match the filter criteria. For example, 
you can filter the Message Summary to show messages of the type informational 
only. 

Attention
Depending on your security privileges, you may not be able to filter and sort the Message 
Summary. The options that are not available to you are disabled and appear “grayed out”.
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Sorting allows you to set the order in which messages appear in the summary. The 
sort order can be ascending or descending. For example, you can sort messages 
by date and time, in ascending order. This means that messages are listed in order 
of ascending date and time, that is, the oldest message is listed at the top of the 
summary.

You can apply more than one filter at a time and you can also filter and sort at the 
same time. When the Message Summary is filtered, the column by which you are 
filtering is highlighted. When the Message Summary is sorted, the column by 
which you are sorting has an up arrow to indicate Sort Ascending and a down 
arrow to indicate Sort Descending.

An easy way to filter the summary is to perform a “like currently selected” filter. 
For example, if you want to see all messages for a particular point. You can select 
the message for the particular point, click the Source column and select (like 
currently selected). The Message Summary is filtered to show all messages in the 
summary that match the source of the currently selected message.

To filter the Message Summary:
1 Call up the Message Summary display.

2 Click the column heading you want to filter by.

3 Select the filter you want to apply.

Example scenario
You want to filter the Message Summary so that you see informational messages.

Solution
1 Call up the Message Summary display.

2 Click the Message State column and select Informational.

The Message Summary changes to list messages that are of the type 
informational.

To sort the Message Summary
1 Call up the Message Summary display.

2 Click the column heading you want to sort by.

3 Select the sort order.
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Example scenario
You want to sort the Message Summary so that messages are sorted in ascending 
order by asset.

Solution
1 Call up the Message Summary display.

2 Click the Location column.

3 Select Sort Ascending.

The Message Summary changes to list messages in ascending order according to 
the asset.

To remove filtering and sorting:
• Click Show All Messages.

Using the Location pane
The Location pane provides a list of assets to which you have access. You can use 
the Location pane to filter the Message Summary to show messages for a 
particular asset only. 

To display the Location pane use either method:
• Click the Show Location Pane icon.

• Click the Location list and click the Push Pin to dock the Location pane.

To hide the Location pane use either method:
• Click the Hide Location Pane icon.

• Click the Close icon in the Location Pane.

Using the details pane
The details pane shows the details of the currently selected message. If no 
message is selected, the details pane is empty.

To show or hide the details pane:
• Click the Details pane icon.
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Navigating the Message Summary
There are several ways to scroll the list of messages on the Message Summary. 
You can:

• Use your mouse and click on the scroll bar

• Use the mouse wheel (if your mouse has one)

• Use the UP ARROW and DOWN ARROW keys on your keyboard

• Press the PAGE UP and PAGE DOWN keys to scroll a page at a time

• Press the HOME key to go to the first message in the summary

• Press the END key to go to the last message in the summary

If you want to use your keyboard keys or the mouse wheel to scroll the Message 
Summary, you need click your mouse in the summary grid to give it focus.

Pausing the Message Summary
You can pause the Message Summary to make it easier to read if messages are 
occurring in rapid succession. When the Message Summary is paused no new 
messages are added to the summary, however you can still acknowledge 
messages and filter and sort the summary. Messages that are acknowledged while 
the summary is paused are shown with a strikethrough.

To pause the Message Summary:
• On the Message Summary display click Pause.
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Acknowledging messages
There are several ways of acknowledging messages:

To: Do this:
Acknowledge or confirm a single 
message

Either:
• Select the message and click the (Alarm 

Acknowledge) toolbar button.
• Right-click the message then select 

Acknowledge.
• Select the message and press the appropriate 

key—see “Keyboard shortcuts” on page 164

Acknowledge all currently visible 
messages

Click the Acknowledge Page button on the 
display. Note: You cannot use this button to 
acknowledge messages that require electronic 
signatures. See “Acknowledging messages with 
Electronic Signatures” on page 102.
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Acknowledging messages with Electronic Signatures
Certain types of messages require either a single or double confirming signatures 
before they can be acknowledged. A single signature icon or a double 
signature icon in the Message Summary indicates how many signatures are 
required.

You must have the appropriate security level to acknowledge single signature 
type messages. The minimum security level required is shown in the Electronic 
Signature dialog box that opens when you select the message from the Message 
Summary. If the message icon in the summary indicates that a secondary signer is 
also required, the opened dialog box will contain two tabs, one for each of the 
signers. 

To sign with a single electronic signature:
1 Select the message and click the (Alarm Acknowledge) toolbar button.

2 Confirm the acknowledgement. 
The Electronic Signature dialog box opens.

3 Select a predefined reason from the Reasons list (if applicable).

4 Type your user name if required.

5 Type your password if required.

6 Type your domain if required.

7 Type any additional information under Comments.

8 Click OK.
The message confirmation is sent to the controller and the message is removed 
from the message summary. An event is generated recording your name as the 
signer.

To sign with a double electronic signature:
1 Select the message and click the (Alarm Acknowledge) toolbar button.

2 Confirm the acknowledgement. 
The Electronic Signature dialog box opens.

3 Click the Primary signature tab and type your user name if required.

4 Select a predefined reason from the Reasons list (if applicable).

5 Type your password if required.

6 Type your domain if required.

7 Type any additional information under Comments.
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8 Click Sign.
Your signature is locked in and cannot be changed.

9 Click the Secondary signature tab.
The secondary signer must have a different user name from the primary signer 
and must have the minimum security level displayed in the Secondary 
signature tab.

10 The secondary signer types their user name, domain and password.

11 Any additional information, if required, is added in Comments. 

12 Click OK.
The message confirmation is sent to the controller and the message is removed 
from the Message Summary. Events are generated recording the names of the 
signers.
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Adding comments to a message
If required, you can add comments to messages in the Message Summary. For 
example, you might need to add details about your response to a message.

To add a comment to a message:
1 Select the message to which you want to add a comment.

2 If the Details Pane is not visible, click the Show Details Pane button.

3 Click the Comments tab.
Any existing comments that have been added to a message are displayed.

4 Type in your comment and click Save Comments.
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An alert is similar to an alarm. An alert notifies you of action you need to take to:

• Complete manual tasks within an overall procedure, for example, shutdown 
procedures. (These types of alerts are linked to Interactive Instructions.)

• Avoid problems if a condition is not fixed.

The priority of the condition is not high enough to be an alarm. 

For example, the gas pressure in Pipe A has been rising steadily over the last 
couple of days, most probably due a build-up of waste particles on the inner 
lining. This is leading to a degradation in process performance. An alert is raised 
to indicate that pipe cleaning must take place in the next week.

Tip
The Alert box in the Status Line flashes white if there are any unacknowledged alerts.
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The Alert Summary
Alerts are listed in the Alert Summary, which provides description of each alert.

To call up the Alert Summary:
1 Choose View > Alerts. (Alternatively, click the Alert box in the Status Line.)

Figure 17 The Alert Summary
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Changing what is shown in the Alert Summary
By default, the Alert Summary shows all alerts, with the newest alert at the top. 
You can change the Alert Summary by applying filters and sorting the summary.

Filtering the Alert Summary allows you to show alerts that match the filter 
criteria and hide alerts that do not match the filter criteria. For example, you can 
filter the Alert Summary to show alerts for a particular asset only. You can filter 
the Alert Summary by most columns in the summary. 

Sorting allows you to set the order in which alerts appear in the summary. The 
sort order can be ascending or descending. For example, you can sort alerts by 
date and time, in ascending order. This means that alerts are listed in order of 
ascending date and time, that is, the oldest alert is listed at the top of the summary.

You can apply more than one filter at a time and you can also filter and sort at the 
same time. When the Alert Summary is filtered or sorted, the column by which 
you are filtering or sorting is highlighted.

To filter the Alert Summary:
1 Call up the Alert Summary display.

2 Click the column heading you want to filter by.

3 Select the filter you want to apply.

Using views
You can change how information is displayed in the Alert Summary by applying a 
different “view”. A view contains the information about filtering and sorting, 
which line items are shown, the order they are shown in and the space provided 
for each item.

There are several predefined views. These are:

• (all alerts)—shows all alerts 

• (my private alerts)—shows alerts for which the current operator is the author 

• (my private and public alerts)—shows alerts for which the current operator is 
the author, as well as any alerts marked as public 

There may be other views that have been configured for your system. Ask your 
supervisor or an experienced colleague about other views and the information 
they display in the Alert Summary.
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To apply a view:
1 Click the view list.

2 Select the view from the list.
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Acknowledging an alert
There are several ways of acknowledging alerts:

Responding to an alert with Interactive Instructions
If the alert is associated with Interactive Instructions, you must complete some 
manual tasks in order for an overall procedure to complete. These tasks are 
detailed in the Interactive Instructions.

To respond to an alert with Interactive Instructions:
1 Call up the Alert Summary.

2 Double-click the alert with Interactive Instructions.
The Sequential Control Module detail display opens at the Table view tab with 
the current step highlighted.

3 Follow the instructions associated with the current step.

4 After you have completed the instructions confirm that you have completed 
the step.

5 Repeat for each step of the sequential control module.

To: Do this:
Acknowledge or confirm a single 
alert

Either:
• Select the alert and click the (Alarm 

Acknowledge) toolbar button.
• Right-click the alert then select Acknowledge.
• Select the alert and press the appropriate key—

see “Keyboard shortcuts” on page 164

Acknowledge all currently visible 
alerts

Click the Acknowledge Page button on the 
display. 
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10Displaying detailed process 
information

To learn about: Go to:
Point Detail displays, which show detailed information about every point page 113

Group displays, which show important information about groups of related 
points

page 120

Trend displays, which display system information in a graphical manner. page 121



10 – DISPLAYING DETAILED PROCESS INFORMATION

112 www.honeywell.com/ps

About Detail displays
Detail displays show information about a particular part of your process or 
specific points. There are several types of Detail displays:

• Point Detail displays

• SCM Detail displays

• Group displays

• Trend displays
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Using Point Detail displays
A Point Detail display shows the current value of each parameter for a particular 
point.

You can also use a Point Detail display to disable the point or change parameter 
values, providing you have the required security level. See “Controlling points” 
on page 58.

Point Detail Displays have a standardized layout, as shown in the following 
figure.

The Face Plate is designed to look like a traditional panel instrument, and shows 
the main parameters for the point.

The other parameters are shown to the right of the Face Plate, and are grouped 
according to tab. For example, to see the alarm-related parameters, click the 
Alarms tab.

Calling up a Point Detail display
There are several ways of calling up a Point Detail display.

To call it up for a point associated with a display object:
1 Click the display object to select it.

2 Click the (Detail) toolbar button to call up the associated Point Detail 
display.

Alternatively, you can simply double-click the display object.

Face Plate Parameters

Tabs
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To call it up for the point in the Alarm Line:
1 Click the (Detail) toolbar button.

To call it up for a point whose ID (or the first part of it) you know:
1 Type all or part of the point ID in the Command Zone, and then click the 

(Detail) toolbar button.

2 If you typed only part of the ID, a list of matching points (and other items) 
appears. Double-click the required point name.

If your system uses DSA or point servers, information on some points you may 
need to access is stored on remote computers. As a result, the first time you call 
up the point’s details you may need to type the full point ID. After this, using part 
of the point ID produces a matching point.

To call it up for a point whose full item name (or the first part of it) you know:
1 Type all or part of the full item name in the Command Zone, and then click the 

(Detail) toolbar button.

2 If you typed only part of the full item name, a list of matching points (and 
other items) appears. Double-click the required point name.

Displaying point history

To see changes to a point’s PV (process value) over time:
1 Display the point’s Detail display—see “Calling up a Point Detail display” on 

page 113.

2 Click the History tab. 
This tab contains a set of History buttons.

3 Select the appropriate graphing options. For example, to see changes at 
minute intervals, select 1 minute from the Interval list.

Process point
A process point represents a control strategy in an Experion Process Controller. 
Process points are user-definable—ask your supervisor or an experienced 
colleague for an explanation of the display’s contents.
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Figure 18 A typical Detail Display for a process point

Item Description
Face Plate (left-hand side) Designed to look like a physical panel, this shows the 

current values of the main parameters. The “gauge” in 
the upper portion shows the PV (process value) and SP 
(setpoint). 

Tabs Related parameters are grouped under each tab. To see a 
particular set of parameters, click the appropriate Tab.
If you want to display changes in PV over time, see 
“Displaying point history” on page 114.



10 – DISPLAYING DETAILED PROCESS INFORMATION

116 www.honeywell.com/ps

Using sequential control module detail displays
Sequential control can be designed to execute basic sequential process activities 
such as start up and shut down as well as complex batch operations. Sequential 
control interacts with one or more control modules. Control Modules can be 
configured to control a PID loop, discrete valves, accumulated flows, and so on. 

Sequential control module (SCM) detail displays are similar to other detail 
displays. They contain a faceplate on the left-hand side and a series of tabs the 
provide more detail of the SCM. From the SCM detail display, you can view the 
SCM as a chart or as a table.

Chart view
An SCM contains transition block and step block pairs. In general, when a certain 
transition condition is met, the step procedure is executed. The chart view gives 
you a graphical view of the transitions and steps in the SCM and the progress as it 
occurs.
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As an SCM runs, the transitions and steps change color. The following table lists 
the colors and their meaning.

Item Color State
Transition block Gray The transition block is waiting to run.

Green The transition block is running

Blue The Transition is complete

Transition 
conditions

Green The condition is true.

Background The condition has not been met.

Red The condition is failed or in error.

Yellow Warning

Step block Gray The step block is waiting for the conditions in the 
preceding transition block to become true for it to run.

Green The step block is running.

Blue The step block has completed.

Step Output Green The step output is OK.

Yellow Warning

Red The step has failed or there is an error and the step 
cannot be complete.
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Table view
The Table view of an SCM contains a series of panes that provide more 
information about the SCM. The panes are:

Pane Description
Summary pane Provides an overview of the SCM in a list or flow 

view.

Details pane Provides more detail of the step that is highlighted in 
the Summary pane. Any interactive instructions are 
also provided in this pane.

Minitrend pane Up to eight values can be trended on a Minitrend. If 
history collection is configured for the current value 
and history collection type is specified in step 
configuration, the Minitrend can retrieve old values. 
For all other current values, Minitrend starts to collect 
the values when the Minitrend is opened for a step in 
Table View.

Key parameters pane Displays the Target value and Entry values. Operator 
can enter an Entry value.

Additional details pane Provides details for the Step Output or Transition 
Condition that is selected in the Details pane.
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Using faceplates
Some points can be controlled from a faceplate. A faceplate is a specialized type 
of popup window that shows critical information about the point to which the 
object is linked. In most cases, a faceplate is similar to the left-hand portion of the 
matching point detail display. 

Each Station can have a total of four faceplates, or popup windows, or a 
combination of both, visible at the same time. For example, if there are already 
three faceplates and one popup windows visible, when you call up another 
faceplate the oldest faceplate (or popup) is replaced.

When you first call up faceplates, they are positioned in the bottom right-hand 
corner of your monitor. You can move the faceplates by clicking and dragging the 
faceplate to another position. Next time you call up the faceplate, the last position 
is remembered.

If you want faceplates to remain visible while you navigate to other displays, 
click the pushpin . Faceplates that you have “pushpinned” are not replaced if 
you call up more faceplates. If you are using a multi-window Station show 
display windows are controlled by Safeview, these rules may be overridden by 
Safeview’s configuration; check with your supervisor or an experienced 
colleague.

You can tell if a display object on a custom display has a faceplate associated with 
it because the mouse pointer changes to a hand when you move the mouse over 
the object. If you click the display object the faceplate for that point opens. You 
can then change parameter values from the faceplate.
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Using Group Detail displays
A Group Detail display shows the main parameters for a set of up to eight related 
points. The information is presented using faceplates. A faceplate is a specialized 
type of popup window that shows critical information about the point to which 
the object is linked. In most cases, a faceplate is similar to the left-hand portion of 
the matching point detail display.

Each group is identified by a number, and generally has a descriptive title.

To call up a group detail display by choosing it from list of groups:
1 Select View > Group Summary to see the list of groups.

2 Select a group.

To call up a group detail display whose number you know:
1 Click the (Group) toolbar button.

2 Type the group number in the Command Zone and press ENTER.

3 If required, you can display the group’s trend by choosing the option from the 
View As list.

You can call up another group by choosing it from the Group list.

Figure 19 Typical Group Detail display
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Using trend displays
A trend display shows changes in point parameter values over time. Typical uses 
of trend displays are to show changes in room temperature or power consumption 
over the day.

Trends can display data in several ways, including:

• Line graphs (the default)

• Bar graphs

• Numerical list of historical data

• X-Y plot of the value of one point against another (that is, one point on the x-
axis and the other on the y-axis)

Each trend is identified by a number, and generally has a descriptive title.

To call up a trend by choosing it from list of trends:
1 Select View > Trend Summary to see the list of trends.

2 Select a trend.

To call up a trend whose number you know:
1 Click the (Trend) toolbar button.

2 Type the trend’s number in the Command Zone and press ENTER.

Figure 20 Typical trend
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You can call up another trend by choosing it from the Trend list.

Modifying a trend display
Having called up a trend, you use the various buttons on the trend display to 
modify it. The following table describes each button.

Button Description
Individual scales in EU
Scaling used in the trend is separate for each point and is in 
engineering units. 
Click the arrow to change the scale.
For more information about scaling trends, see “Changing the scale 
on a trend” on page 124.

Individual scales in %
Scaling used in the trend is separate for each point and is shown as a 
percent.
Click the arrow to change the scale.
For more information about scaling trends, see “Changing the scale 
on a trend” on page 124.

Single scale for all plots
The range displayed on the Y-axis is the same for all plots.
For more information about scaling trends, see “Changing the scale 
on a trend” on page 124.

Plot selector
Indicates the plot that is currently selected, or if no plot is currently 
selected, indicates the last plot you selected. If you are not using a 
single scale for all plots, the Y-axis displays the scale for the plot that 
is shown in the box.

Display as bar graph
The selected point is displayed as a bar graph. Data for the remaining 
points is obscured by the bar graph. 
Click the arrow to change from a bar graph to a line graph.

Display as line graph
The plots are displays as line graphs.
Click the arrow to change from a line graph to a bar graph.
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View single trend only
Indicates the current view is a single trend without the event pane or 
the tabular history pane.
Click the arrow to change the view to Trend with Events or Trend 
with Tabular History

View trend with tabular history
Indicates the current view is the trend with the tabular history pane. 
Click the arrow to change the view to Single Trend Only or Trend 
with Events.

View trend with events
Indicates the current view is the trend with the event pane.
Click the arrow to change the view to Single Trend Only or Trend 
with Tabular History.

Show legend
Shows or hides the legend for this trend.

Configure trend
Calls up the Trend Configuration display.

Save trend
Saves any changes you have made to the trend. After you save, the 
changes are made available to any other operators viewing the trend.

Pause live updates
Pauses the trend so that data is not updated. A trend is automatically 
paused when you zoom in and out.

Resume live updates
Restores the trend so that it is updated with live data.

Remove reference line
Removes the reference line.

Reset zoom level
Resets the zoom level.

Zoom in
Zooms in by 25% of the visible range. If a reference line is visible, the 
zooming is centered around the reference line.

Zoom out
Zooms out by 25% of the visible range. If a reference line is visible, 
the zooming is centered around the reference line.

Button Description
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There are some trends that operate in a different manner to the default trend, these 
trends are the dual, triple, and X-Y trends. You can modify these types of trends 
by changing the:

• Period

• History offset

• Scale to use engineering units or percentage

• Points

Changing the scale on a trend
When viewing a standard trend, you can change the scale that is used for the 
trend. For example, you can switch from having a single scale for all plots to 
individual scales, in engineering units, for each plot. The following figure, Scale 
options for a standard trend, shows the scale options available in a list which you 
can access from the trend toolbar. 

The following table describes all the scale options available for a standard trend.

Show time selector
Shows the time selector and provides options for the position of the 
time selector which is used to set a history offset.

Button Description

Figure 21 Scale options for a standard trend

Scale option Description
Individual scales in EU You specify the maximum and minimum value that 

will be shown on the trend for each plot individually. 
Values that fall outside this scale are not visible in the 
trend.
The scale is represented in engineering units.
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To specify an individual scale:
1 Call up the trend.

2 Click arrow on the scale toolbar button at the top of the trend.
The button shown depends on the type of scale currently in use for the trend.

3 Select the required individual scale.

4 In the Low Scale box on the legend, type the low scale value for each plot.

5 In the High Scale box on the legend, type the high scale value for each plot.

Individual scales in % You specify the maximum and minimum value that 
will be shown on the trend for each plot individually. 
Values that fall outside this scale are not visible in the 
trend.
The scale represents the point parameter range in 
percentage terms. A scale of 0% to 100% shows the 
full range of the point parameter and correlates to the 
minimum and maximum value for the point 
parameter. You may want to increase or decrease the 
scale, depending on the range of your point and the 
actual historical values of the point.

Single scale for all plots One scale is used for all points in the trend. You 
specify the maximum and minimum value that will be 
shown on the trend. Values that fall outside this scale 
are not visible in the trend.

Auto scale current plot Adjusts the selected plot so that it is centered 
vertically in the chart and scaled such that the plot 
uses most of the vertical chart space.

Auto scale all plots Adjusts all plots that are currently visible so that they 
are centered vertically in the chart and scaled such 
that each plot uses most of the vertical chart space.

Scale to point ranges in EU The scale is set so that it correlates with the maximum 
and minimum point parameter range of all points in 
the trend and is shown in engineering units.

Scale to point ranges in % The scale is set so that it correlates with the maximum 
and minimum point parameter range of all points in 
the trend and is shown in percentage terms. The 
minimum point parameter value is always 0% and the 
maximum point parameter value is always 100%.

Revert to saved ranges The scale options is restored to what was last saved 
for the trend. Any changes to the scale that were not 
saved are removed.

Scale option Description
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To specify a single scale:
1 Call up the trend.

2 Click arrow on the scale toolbar button at the top of the trend and select Single 
scale for all plots.
The button shown depends on the type of scale currently in use for the trend.

3 On the y-axis, type the low and high scale value.

Viewing events on a trend
You can view events with your trend to help you analyze the relationship between 
alarms and events and changes in point values in your trend. 

When viewing events, an Event Summary is added beneath the chart area of the 
trend and markers appear on the chart area of the trend to identify when events 
occurred.

The Event Summary on the trend display can be filtered in the same manner as 
the standard Event Summary. For more information on filtering the Event 
Summary, see “Changing what is shown in the Event Summary” on page 84.

To view events with your trend:
1 Call up your trend display.

2 Click the View trend with events button.

3 Filter the Event Summary as required.

It is important to note that the Event Summary only shows the events from the 
local server only. Distributing all events would need significant bandwidth as 
most events are recorded only on the server where the point is defined. The 
exceptions to this are the Acknowledgement events and Point Change events, 
which are recorded on both the server where they occurred and on the data owner. 
For more information viewing events on a remote server, see “Journaled events” 
on page 83.

Changing the period on a trend
To change the period, you specify the length of time, for example, 2 hours, and 
then specify which 2 hours you want to see.

Tip
If you find a correlation between an event and changes in values in the trend, you can add 
comments to the event.
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You specify a period that either:

• Starts at a specific date and time by showing the time selector on the left.

• Ends at a specific date and time, by showing the time selector on the right.

• Starts and ends at a specific date and time by showing the time selector on the 
left and right.

• Is centered around a specific date and time by showing the time selector at the 
center.

To change the period on the trend you are viewing:
1 In the Period box, select the period you want to see on your trend.

2 Click the Time selector  and choose the required position of the selector.

3 In the Date box, type or select the required date.

4 In the Time box, type the required time and press ENTER.

Zooming in on a trend display

To zoom in on a trend:
1 Move the pointer to, for example, the top-left of the area of interest, and then 

drag the pointer diagonally down to the bottom-right.
As you drag, a rectangle shows the area you are selecting.

2 Release the mouse button when the rectangle encloses the area of interest—
the trend now zooms in on this area.

3 To zoom back out to the trend’s normal scale, click the  button at the 
bottom-right of the trend.

Highlighting a plot on a trend
You may find it useful to highlight a particular plot on the trend. By highlighting a 
plot, the plot line is bolded, making it easier to see against other plots in the trend.

There are also some functions that work on a single plot, in which case you must 
highlight the particular plot to apply these functions, for example, showing a plot 
as a bar graph.

Tip
You can also use the Zoom in  button to zoom in on a trend. The zoom button centers 
the trend around the reference line. If there is no reference line the trend is zoomed around 
the center of the chart.
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There are two ways to highlight a plot on a trend:

• Using the plot list above the chart area 

• Using the legend 

If you want to remove the bold formatting from the plot, click the number of the 
plot in the legend.

Use the list to highlight a plot
or
Use the legend to highlight a plot

Click here to remove the bold 
formatting from the plot
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11Loading recipes

You need to ask your supervisor or an experienced colleague whether you have 
the Recipe Manager option.

The Recipe Manager allows you to load predetermined values into appropriate 
point parameters. (A recipe consists of a set of predetermined values and their 
associated point parameters.)

Prerequisites
• To load a recipe you need to know the unique two-digit number for each unit. 

Ask your supervisor or plant engineer for the required unit numbers.

To load a recipe:
1 Select Action > Load Recipe to see the list of recipes.

Figure 22 The Recipe Summary
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2 Click the recipe you want to load. The recipe’s details appear.

3 If you want to change the recipe before loading it, see “Customizing a recipe” 
on page 131.

4 Type the unit (set of equipment) into which you want to load the recipe in the 
Unit box.

5 Click the Load button.
The Recipe Last Loaded, With Scale and To Unit boxes are updated when 
the recipe is loaded.
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Customizing a recipe
In some cases you may need to customize a recipe before loading it. For example, 
if the recipe controls the production of fertilizer, you may need to scale down the 
recipe so that it makes the correct amount of fertilizer. Alternatively, you may 
need to override some of the recipe’s master values for the particular task you are 
about to perform.

To scale a recipe:
1 Click the Scale box and type the scale percentage.

100% uses the master values, whereas 50% halves them. Note that scaling 
only affects the parameters for which Scaled is set to Yes.

To override one or more master values:
1 Select the appropriate Working box and type the appropriate value. (This 

value must be between the minimum and maximum values.)
Repeat this for any other working values you want to change.
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12Monitoring system status

The status displays provide detailed status information about your system’s 
hardware components, such as printers, controllers and channels.

The System Status display shows alarms for all system components. You can 
navigate to a status display for a particular system component from the System 
Status display by double-clicking the alarm. For more information about the 
System Status display see the section, “The System Status display” on page 69.
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Monitoring channel status
A channel is a physical communications link, such as a network cable, between 
the server and one or more controllers.

The Channels Status display shows the status of each communications channel, as 
well as its type.

To call up the Channels Status display:
1 Select View > System Status > Channels. 

(Note that the display will be slightly different if your channels are dual 
communication links—such channels continue to allow communications 
between the server and the controller if one link malfunctions.)

2 If you want to see more information about a channel, click it to call up the 
channel’s Detail display. This shows Error Statistics and Barometer values 
that indicate the “health” of the channel. (For a healthy channel, the 
Barometer’s Current value is less than the Marginal limit.)

3 If you want to see information about the controller(s) attached to a particular 
channel click the Controllers button.

Figure 23 Channel Status
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MONITORING CHANNEL STATUS

Tip
If a channel fails, you can disable it by clearing the Enable check box. However, if you do 
this, you must select the Enable check box after rectifying the problem to ensure that the 
channel is re-enabled.
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Monitoring system interfaces status
The System Interfaces Status Summary display shows the status of each system 
interface. The display shows the system interface type, alias, and status.

To call up the System Interfaces Status Summary display:
1 Click System Status on the System Menu and then click System Interfaces 

on the Navigation Pane.)

Figure 24 System Interfaces Status Summary
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Monitoring controller status
The Controllers Status display shows the status of each controller, as well as its 
type, and the channel it is on.

To call up the Controllers Status display:
1 Select View > System Status > Controller. 

(Note that the display will be slightly different if your controllers use dual 
communication links—such controllers continue communicating with the 
server if one link malfunctions.)

2 If you want to see a list of controllers for a particular point server or channel, 
select the point server or channel from the list.

3 If you want to see more information about a controller, click it to call up the 
controller’s Detail display. This shows Error Statistics and Barometer 
values that indicate the “health” of the controller. (For a healthy controller, the 
Barometer’s Current value is less than the Marginal limit.)

Figure 25 Controller Status

Tip
If a controller fails, you can disable it by clearing the Enable check box. However, if you 
do this, you must select the Enable check box after rectifying the problem to ensure that 
the controller is re-enabled.
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Monitoring Experion process controllers
You monitor Experion process controllers using specialized point detail displays. 
The Control Process or Module (CPM) and the Control Execution Environment 
(CEE) each have separate detail displays.

To call up these displays, type the object name in the Command Zone and click 
(Detail), or press F12.
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MONITORING SYSTEM MANAGEMENT SERVERS

Monitoring System Management Servers
The System Management Servers status display shows the status of the System 
Performance Server and the System Event Server.

To call up the System Management Servers Status display:
1 Select View > System Status > System Management Servers.

Figure 26 System Management Servers Status
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Monitoring Flex Station status
The Flex Stations Status display shows the status of each Flex Station, as well as 
its keyboard type, and current operator.

To call up the Stations Status display:
1 Select View > System Status > Stations > Flex Stations. 

Figure 27 Flex Station Status
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MONITORING CONSOLE STATION AND CONSOLE EXTENSION STATION STATUS

Monitoring Console Station and Console Extension 
Station status

The Console Station Status display shows the status of each Console Station and 
any connected Console Extension Stations.

To call up the Console Station Status display:
1 Select View > System Status > Stations > Console Stations. 

2 Click the Console Station to view more detailed status information.

Figure 28 Console Station Status Summary
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Figure 29 Console Station Status
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MONITORING CONSOLE STATUS

Monitoring console status
The Console Status display shows the status of each Console and the status of the 
Console Stations and Console Extension Stations that form the console.

To call up the Console Status display:
1 Select View > System Status > Console Stations. 

2 Click the console to view more detailed information.

Figure 30 Console Status summary
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Figure 31 Console Status 
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MONITORING PRINTER STATUS

Monitoring printer status
The Printers Status display shows the status of each printer.

To call up the Printers Status display:
1 Select View > System Status > Printers. 

Figure 32 Printer Status

Tip
If a printer fails, you can disable the printer by clearing the Enable check box. However, 
you must re-enable the printer after you have rectified the cause of failure.
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Monitoring a redundant server system
A redundant server uses two servers that operate in parallel. During normal 
operation, the primary server performs all tasks, and the backup server 
“watches”. However, if the primary server fails, the backup server immediately 
takes over, without any interruption to your system.

The Server Redundancy Status display shows the status of the two servers, and 
whether they are synchronized.

To call up the Server Redundancy Status display:
1 Select View > System Status > Server Redundancy. 

Figure 33 Redundant Server Status
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MONITORING DISTRIBUTED SYSTEMS

Monitoring distributed systems
In a Distributed System Architecture (DSA) configuration each server is 
responsible for managing a specific part of your system.

The Distributed System Status display shows the status of each server, as well as 
its type.

To call up the Distributed System Status display:
1 Select View > System Status > Distributed Systems. 

2 Click on the name of the server whose status you want to check. 

Figure 34 Distributed Servers Display
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Figure 35 Distributed Servers Status Display
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13Communicating with your 
colleagues

Station provides Message Pad for communicating with your colleagues.

The Message Pad is like a bulletin board in that it can be read by anyone who has 
access to Station. As the name implies, the primary purpose of the notes are to tell 
colleagues on the next shift about any important events.

To read the Message Pad:
1 Select View > Message Pad. (Alternatively, click Message Pad on the 

System Menu.)

To clear any existing notes and add your own notes:
1 Select View > Message Pad.

2 Click the Clear button.
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3 Click in the note area. (Alternatively, press the TAB key until the note area is 
highlighted.)

4 Start typing your note.

5 When you have finished, click the Save button.

To add to the existing note:
1 Select View > Message Pad.

2 Click below the existing note.
You may need to press ENTER to start a new line.

3 Start typing your note.

4 When you have finished, click the Save button.
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14Producing reports

Reports summarize historical information in many useful ways. For example, one 
report may consist of graphs of system-critical values over the past week, whereas 
another report may list equipment that is due for service.

All reports need to be requested, either manually or automatically. Requesting a 
report generates a new version, using the latest data. For example, if you have a 
report called “Weekly Status Report”, you would need to request it each week so 
that it contains the current week’s data. See “Requesting a report” on page 152.

Depending on how a report is configured, it is printed, or saved to computer file 
so that it can be viewed on screen or used by another program. If the report is 
designed to be viewed on screen, you need to call it up after generating it—see 
“Viewing a report” on page 153.

For alarm, events and message summaries, you can use the Print As Report 
feature to produce a printed report containing all, or a range of, the summary 
information within the display. 

If you simply want a printout as a “snapshot” of what is shown in Station, see 
“Printing Station information” on page 53.
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Requesting a report
Considerations
• When you request a report, Experion creates a new version using the latest 

data. For example, if you have a report called “Weekly Status Report”, you 
would need to request on a weekly basis to ensure that the data is always up-
to-date.

To request a report:
1 Select Action > Request Report to see the list of reports. (Alternatively, click 

Reports on the System Menu.)

2 Click the report you want to request.

3 If you want to change the report’s existing settings, click the Configure tab to 
see the configuration details.

4 Change these as appropriate.

5 Click the Request button to request the report.
A “Request in progress” message appears in the Message Zone. The 
document is sent to the specified output device, either a printer or your screen.

Requesting a report from the Command Zone
If you know the number or name of a report, you can request it from the 
Command Zone. (Note that when you request a report this way, the report uses its 
default settings.)

For example, to request report “123”:
1 Click the Command Zone.

2 Type rpt 123 and press ENTER.
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VIEWING A REPORT

Viewing a report
Any report can be viewed on your screen at any time—just like any other display.

For example, to call up report “123”:
1 Click the Command Zone.

2 Type pr 123 and press ENTER.

Attention
Viewing a report simply redisplays the last version that was generated. If you want to 
update the report’s contents, you must request it again—see “Requesting a report” on 
page 152.
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Standard report types
The following table lists standard report types; however, your system will only 
have report types that are applicable to your system’s needs.

Attention
The Integrated Microsoft Excel and the ODBC Data Exchange report types are only 
available if your system has the associated option.

Report type Description
Alarm and Event Lists the alarms or events that occurred within 

the specified time period.

Alarm Duration Lists how long the specified points were in an 
alarm condition.

Batch Batch reports are used to collect history for a set 
of points and events for an asset for the duration 
of a production run. 

Cross-Reference Lists where the specified points are used within 
your system, for example, in custom numbered 
displays, reports, algorithms and so on.

Free Format Enables you to request customized reports that 
have been designed using the Free Format 
Report Writer option.

Integrated Microsoft Excel Enables you to request customized reports that 
have been designed using Microsoft Excel.

ODBC Data Exchange Enables you to request customized reports using 
the ODBC Data Exchange option.

Point Attribute Lists all points with specified attributes, such as 
“off scan” or “alarm inhibited”, or those points 
with the specified state.

Sequence of Events Lists changes in point parameter values of time. 
This report is only available for points associated 
with specific controllers.
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PRINTING REPORTS FROM THE SUMMARY DISPLAYS

Printing reports from the summary displays
If you have the appropriate security level, you can create a report from 
information that is contained in the Alarm, Events or Message Summary displays. 
The data contained in the display is presented in the same order as it appears in 
the display. 

You can limit the amount of data your report contains by setting your filter 
criteria. For example, you might include only the events that occurred after a 
certain time, or only those messages that have been received on a given day. See 
“Changing what is shown in the Alarm Summary and the System Status display” 
on page 72. Additional information can be found in “Changing what is shown in 
the Event Summary” on page 84, or “Changing what is shown in the Message 
Summary” on page 97.

You can view the report from a separate window on your screen by clicking Print 
Preview . You can print the report on the default Windows printer, or you can 
select a different printer if one is available.

When you click Print as Report , the report is sent to the default printer, or 
the printer you have selected from the Print Preview window. 

A message indicates that a print preview or print request is in progress.

A message warns you if the generated report is more than 10 pages. You may 
want to reduce the size of the report by redefining your filter criteria.

If your on-screen alarm data includes graphic indications of an alarm states, these 
alarm states will be converted to text abbreviations in your report. A key to 
abbreviations is added to the bottom of each report page.

To print a report from a summary display:
1 Call up the summary display that you want to use for a report.

2 Create your filter selection to display only the data you want in your report.

3 Click Print Preview to view the report on-screen.

4 Click Print As Report to create a printed report.
When the Print dialog box is displayed, set your printing options such as page 
orientation, printer selection, and so on.

Tip
You can also export the report to a standard file format that can be read by other 
applications.
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15Reference information

To learn about: Go to:
Commands you can select from the menus page 158

Commands you can issue from the Command Zone page 162

Keyboard shortcuts page 164

Changing someone’s Station password page 174
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Menu summary
Notes
• Your system may contain one or more customized menus that are unique to 

your system. Ask your supervisor or an experienced colleague for a 
description of the commands in these menus.

• This topic does not describe configuration-related menus, such as the 
Configure menu, that are only used by engineering staff.

Station menu

Edit menu
These are editing commands that are of use when using the Message Pad—see 
“Communicating with your colleagues” on page 149.

Command Description
Connect… Opens a specific Station setup file. See “Changing 

Station’s setup file” on page 28.

Logon… Allows you to type the password for a higher security 
level.

Connection Properties… Allows you to view and change Station’s settings.

Exit Exits (closes down) Station.

Command Description
Cut Removes the selected text and inserts it into the 

clipboard.

Copy Inserts a copy of the selected text into the clipboard.

Paste Inserts the clipboard’s contents into the Message Pad.
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View menu

Control menu

Command Description
Detail Calls up the detail display for the selected point.

Associated Page Calls up the selected object’s associated page.

Reload Page Reloads the current page.

Alarms Calls up the Alarm Summary. See “Responding to 
alarms” on page 65.

System Alarms Calls up the list System Status display. See “The System 
Status display” on page 69.

Messages Calls up the Message Summary. See “Responding to 
messages” on page 95.

Alerts Calls up the Alert Summary. See “Responding to alerts” 
on page 105.

Display Summary Calls up the list of numbered custom displays (named 
custom displays are not included).

Events Calls up the Event Summary. See “Responding to 
events” on page 81.

Group Summary Calls up the list of group displays. See “Using Group 
Detail displays” on page 120.

Message Pad Calls up the Message Pad. See “Communicating with 
your colleagues” on page 149.

Report Summary Calls up the list of reports available on your system. See 
“Producing reports” on page 151.

System Status Calls up the selected system status display.

Trend Summary Calls up the list of trend displays. See “Using trend 
displays” on page 121.

Show Full Page Resizes the Station window so that the entire display is 
visible in the window without scroll bars.

Command Description
Raise
Lower
Select Setpoint
Select Output

These commands are used together to raise or lower the 
SP (setpoint) or OP (output) of the point associated with 
the selected object.
See “Controlling points” on page 58.
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Action menu

Help menu
These commands provide access to this guide and other Experion documentation.

Control to Manual Sets the selected object to manual control mode.

Control to Automatic Sets the selected object to automatic control mode.

Control to Normal Sets the selected object to normal control mode.

Enable/Disable Toggles the state of the selected object.

Command Description

Command Description
Acknowledge Acknowledges an alarm.

Silence Silences an alarm.

Request Report Generates the requested report. See “Requesting a 
report” on page 152.

Load Recipe Loads the specified recipe. See “Loading recipes” on 
page 129.

Print Prints the current display based on the default print 
settings.

Page Setup… Displays the Page Setup dialog box where you can 
specify such things as page size and orientation.

Print… Displays the Print dialog box where you can specify 
such things as the printer you want to print to.

Print Preview… Displays a preview what you want to print.

Command Description
Help for this display Calls up context-sensitive help for the current display.

Operators Guide Calls up this guide.

Station Help Calls up the help for Station.

Knowledge Builder Calls up Knowledge Builder, Experion’s online 
documentation “library”.

Knowledge Builder Search Calls up the search function, which allows you to search 
the whole Knowledge Builder “library” for a particular 
word or phrase.
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VB Scripting Help Calls up the help for VBScript, which you use if you 
write server scripts.

About Station Displays details about Station, such as its revision 
number.

Command Description
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Command reference
After you have become familiar with your system, you can quickly issue 
frequently required commands by typing them in the Command Zone.

Attention
Commands are case-insensitive. For example, you can type bye, BYE or Bye to log off.

Type the command Then press Description
displayname ENTER Calls up the display whose name is displayname.

pointID F12 Calls up the point’s details.
If you only type the first part of the ID, a list of 
matching points appears. You then click the 
appropriate point to display its details.

bye ENTER If you use operator-based security, this command logs 
you off Station. 
If you use Station-based security, this command 
returns Station to the oper security level.

callup n ENTER Calls up display n, (which can be either a number or a 
name) while retaining the current file, record and field 
numbers.

chgpsw ENTER Changes your password. (Only applicable if you use 
operator-based security.)

display n ENTER Displays the description for error n.

fil n ENTER Changes the current file number to n.

fld n ENTER Changes the current field number to n.

grp n ENTER Calls up group display n.

his n ENTER Displays the historical values for group n.

pag n ENTER Calls up display n (which can be either a number or a 
name). For example, to call up display 310, you would 
type: pag 310.

pf file ENTER Displays the contents of file.

pr n 
pr name 

ENTER Views the numbered (n) or named (name) report, 
without updating the report’s contents. 
(Use the rpt command if you want to update the 
contents.)

print file ENTER Prints the contents of file.
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psw ENTER Changes to another security level if you are using 
Station-based security.

rec n ENTER Changes the current record number to n. (Not 
applicable to operators.)

rpt n 
rpt name 

ENTER Generates a numbered (n) or named (name) report.

tnd n ENTER Calls up trend display n.

Type the command Then press Description
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Keyboard shortcuts
The keyboard shortcuts depend on the type of keyboard you use:

• “Shortcut keys for a 12-function keyboard” on page 165

• “Shortcut keys for an IKB (Integrated keyboard)” on page 170

• “Shortcut keys for an OEP (Operator Entry Panel) keyboard” on page 167

If you don’t know what type of keyboard you have, see “Keyboard types” on 
page 41.
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Shortcut keys for a 12-function keyboard
The shortcuts are described according to general function:

• “Calling up displays” on page 165

• “Calling up specialized displays” on page 165

• “Focusing on objects” on page 166

• “Entering data and issuing commands” on page 166

Calling up displays

Calling up specialized displays

To call up: Press:
A display based on its name or number F5

The next display in the current “chain” of related displays or the next set of 
records in a list of records which spans more than one page.

PAGE UP

The previous display in the current “chain” of related displays or the 
previous set of records in a list of records which spans more than one page.

PAGE 
DOWN

The previous display F8

The display associated with the selected object F2

To call up the: Press:
Alarm Summary F3

Search display for points and other system items F12

System Menu F1

Shortcut menu SHIFT + F10
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Focusing on objects
In computing, the phrase “giving an object focus” means marking an object so 
that it can be used or controlled in some way. For example, if you wanted to type 
a new value into a box, you could press the TAB key until the box has focus 
(indicated by highlighting) and then type the new value.

Entering data and issuing commands

To move the focus to: Press:
The next selectable object or editable box TAB

The previous selectable object or editable box SHIFT+TAB

To: Press:
Acknowledge/silence an alarm F4

Copy the selected item to the clipboard CTRL+C

Cut the selected item to the clipboard CTRL+X

Lower the value of the selected object by 1% (default setting) F10

Lower the value of the selected object by 10% (default setting) ALT+F10

Paste the contents of the clipboard into the selected item CTRL+V

Raise the value of the selected object by 1% (default setting) F9

Raise the value of the selected object by 10% (default setting) ALT+F9

Select the object that has focus BACKSPACE

Select the OP of the selected object ALT+F12i 

i Applicable only to points with these types of parameters.

Select the SP of the selected object ALT+F11i 

Set the MD of the selected point to automatic ALT+F6i 

Set the MD of the selected point to manual ALT+F5i 

Set the MD of the selected point to normal ALT+F7i 
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Shortcut keys for an OEP (Operator Entry Panel) 
keyboard

The shortcuts are described according to general function:

• “Display navigation” on page 167

• “Focus changing” on page 167

• “Data entry and control” on page 168

• “System display” on page 168

• “Point detail, trend and group” on page 169

Display navigation

Focus changing
In computing, the phrase “giving an object focus” means marking an object so 
that it can be used or controlled in some way. For example, if you wanted to type 
a new value into the next box, you could press the TAB key—to give it focus—
and then type the new value.

To: Press:
Call up a display based on its name or number SCHEM

Call up the next display upwards PAGE BACK

Call up the next display downwards PAGE FWD

Navigate forward and backward between displays that you have 
previously called up.
DISP FWD does not work if you are using multi-window Station.

PRIOR DISP or DISP 
BACK
DISP FWD

Call up the display associated with the selected object ASSOC DISP

Copy the current display to the first associated Station DISP SET

Print the current display PRINT DISP

Call up display-specific help (If display-specific help is not 
configured, calls up Station Help.)

HELP

To: Press:
Move the focus to any selectable object or editable box in the 
display

Tab Arrow keys
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Data entry and control

System display

To: Press:
Acknowledge/silence an alarm ACK

Silence all audible alarms SIL

Confirm message MSG CONFM

Enable/disable the state of the selected point (the point toggles 
state each time you press the key)

LOAD

Lower the value of the selected object by 1% (default setting)i

i If you press the raise or lower keys faster than the server can respond to, repeated key presses 
are ignored.

LOWER

Lower the value of the selected object by 10% (default setting)i FAST LOWER

Raise the value of the selected object by 1% (default setting)i RAISE

Raise the value of the selected object by 10% (default setting)i FAST RAISE

Select the OP of the selected object OUT

Select the SP of the selected object SP

Set the mode of the selected point to automatic AUTO

Set the mode of the selected point to manual MAN

Set the mode of the selected point to normal NORM

Change the update rate from Normal to Fast, or from Fast to 
Normal (The LED is illuminated when the update rate is set to 
Fast.)

FAST

Clear an incorrect operator entry CLR ENTR

To call up the: Press:
Alarm Summary display ALM SUMM

System Status display SYST STATS

Message Summary display MSG SUMM

Console Status detail displayi CONS STATS

System Menu display SYST MENU
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Point detail, trend and group

Unsupported keys
The following keys are not mapped to any Experion function. If you attempt to 
use these keys, a message appears “Pushbutton not implemented”. Check with 
your supervisor or an experienced colleague if they have been customized for 
your site.

• BATCH

• CANCL PRINT

• GO TO

• RECRD

i The CONS STATS key calls up the Console Status detail display if you are logged on to a 
Console Station or Console Extension Station that is a member of a console. If the Station you are 
logged on to is not a member of a console, then the display called up is the status display for that 
Station. If the Station you are logged on to is a Flex Station, the display called up is the Flex 
Station Status Summary display.

To view: Press:
The point detail display for the selected object. If there is no 
associated point detail display, calls up the point search display.

DETAIL

The Group Trend display for the selected objected. If there is no 
associated Group Trend display, invokes the Group Trend 
command and requires a Group Trend number to be entered.

UNIT TREND

The Group for the selected object. If there is no associated Group 
display, invokes the Group command and requires a Group 
number to be entered.

GROUP

The Trend for the selected object. If there is no associated Trend, 
invokes the Trend command and requires a Trend number to be 
entered.

TREND

Group history for the selected point with the default interval. If 
there is no associated Group History, invokes the Group History 
command and requires a Group History number to be entered.

HOUR AVG
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Shortcut keys for an IKB (Integrated keyboard)
The shortcuts are described according to general function:

• “Display navigation” on page 170

• “Focus changing” on page 170

• “Data entry and control” on page 171

• “System display” on page 171

• “Point detail, trend and group” on page 172

Display navigation

Focus changing
In computing, the phrase “giving an object focus” means marking an object so 
that it can be used or controlled in some way. For example, if you wanted to type 
a new value into the next box, you could press the TAB key—to give it focus—
and then type the new value.

To: Press:
Call up a display based on its name or number SCHEM or F5

Call up the next display upwards PAGE BACK or PgUp

Call up the next display downwards PAGE FWD or 
PgDown

Navigate forward and backward between displays that you have 
previously called up.
DISP FWD does not work if you use multi-window Station.

DISP BACK, or 
PRIOR DISP, or F8
DISP FWD

Call up the display associated with the selected object ASSOC DISP or F2

Print the current display PRINT DISP

Call up site-specific help (If site-specific help does not exists, 
calls up Station Help.)

HELP

To: Press:
Move the focus to the next selectable object or editable box TAB

Move the focus to the previous selectable object or editable box SHIFT+TAB

Move the focus to any selectable object or editable box in the 
display

Arrow keys
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Data entry and control

System display

To: Press:
Acknowledge/silence an alarm ACK or F4

Silence all audible alarms SIL

Confirm message MSG CONFM

Copy the selected item to the clipboard CTRL+C

Cut the selected item to the clipboard CTRL+X

Enable/disable the state of the selected point (The point toggles 
state each time you press the key.)

LOAD or F11

Lower the value of the selected object by 1% (default setting)i

i If you press the raise or lower keys faster than the server can respond to, repeated key presses 
are ignored.

LOWER or F10

Lower the value of the selected object by 10% (default setting)i FAST LOWER 
ARROW or ALT+F10

Paste the contents of the clipboard into the selected item CTRL+V

Raise the value of the selected object by 1% (default setting)i RAISE or F9

Raise the value of the selected object by 10% (default setting)i FAST RAISE or 
ALT+F9

Select the object that has focus SELECT or 
BACKSPACE

Select the OP of the selected object OUT or ALT+F12

Select the SP of the selected object SP or ALT+F11

Set the mode of the selected point to automatic AUTO or ALT+F6

Set the mode of the selected point to manual MAN or ALT+F5

Set the mode of the selected point to normal NORM or ALT+F7

Change the update rate from Normal to Fast, or from Fast to 
Normal (The LED is illuminated when the update rate is set to 
Fast.)

FAST

To call up the: Press:
Alarm Summary display ALM SUMM or F3 or 

UNIT ALM SUMM

System Status display SYST STATS



15 – REFERENCE INFORMATION

172 www.honeywell.com/ps

Point detail, trend and group

Unsupported keys
Some keys in earlier versions of this keyboard are marked with red labels. These 
labels are not applicable to any Experion function.

The following keys are not mapped to any Experion function. If you attempt to 
use these keys, a message appears “pushbutton not implemented”. Check with 
your supervisor or an experienced colleague if they have been customized for 
your site.

• GOTO

Message Summary display MSG SUMM

System Menu display F1

Console Status Summary displayi CONS STATS

System Menu display SYST MENU

i The CONS STATS key calls up the Console Status Summary display if you are logged on to a 
Console Station or Console Extension Station that is a member of a console. If the Station you are 
logged on to is not a member of a console, then the display called up is the status display for that 
Station. If the Station your are logged on to is a Flex Station, the display called up is the Flex 
Station Status Summary display.

To call up the: Press:

To view: Press:
Point detail display for the selected object. If there is no 
associated point detail display, calls up the point search display.

DETAIL or F12

The Group Trend for the selected object. If there is no associated 
Group Trend display, invokes the Group Trend command and 
requires a Group Trend number to be entered.

UNIT TREND

The Group display for the selected object. If there is no 
associated Group display, invokes the Group command and 
requires a Group number to be entered.

GROUP or F6

The Group History with the default interval for the selected 
object. If there is no associated Group History, invokes the Group 
History command and requires a Group History number to be 
entered.

HOUR AVG

The Trend for the selected object. If there is no associated Trend, 
invokes the Trend command and requires a Trend number to be 
entered.

TREND or F7
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• PRINT TREND

• CANCL PRINT

• RECRD

• PROC NETWK STATS

• COMM NETWK STATS

• AM STATS

• ORG SUMM

• UNIT ASGN

• ALM ANNC

• MSG CLEAR



15 – REFERENCE INFORMATION

174 www.honeywell.com/ps

Changing someone’s operator-based security password
You might need to change a user’s password if the user has forgotten the old one. 
When changing the password, remember that it:

• Consists of a minimum of 5 and maximum of 40 letters/numbers, without 
spaces

• Is case-sensitive

Considerations
• You must have MNGR security level to be able to change someone’s 

password.

• If you are using a Console Station, and your system uses separate user names 
and passwords for Windows and Station, you can only change passwords 
when the Experion server is available.

To change the password:
1 Select Configure > Operator Security to see the list of users.

2 Click the user whose password you want to change. The user’s details appear. 
(You can also change these details if required.)

3 Click the Change Password button. 
The Change Password dialog box opens.

4 Type the new password and press the TAB key.

5 Re-type the new password and click OK. (The new password is only accepted 
if the two entries are identical.)
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Alarm Line
Generally, this line displays the most recently unacknowledged alarm message. 
(The Alarm Line may be hidden on your system, or it may be configured to 
operate in a special manner.)

alarm group
A group of assets and points, that are otherwise unrelated to one another in the 
asset model, grouped together for the purpose of alarm monitoring and 
management.

application
A computer program. Station and Experion are both applications, as is Microsoft 
Word.

asset
A representation of entities such as plant equipment, facilities, and buildings. 
Operators or Stations can be assigned access to particular assets only. 

click
The act of momentarily pressing the left mouse button. This is the standard way, 
in Windows, of selecting an object. For example, to select something, you move 
the pointer over the object and then click.

If you have a trackball or touch screen instead of a mouse, see “Using a trackball” 
on page 39 or “Using a touch screen” on page 40, respectively, for the equivalent 
action.

clipboard
A temporary storage space which you use to move text (or images) from one 
application to another, using the Copy, Cut and Paste commands. For example, 
you can use the clipboard to copy text from a word processor document and insert 
(paste) it into Station’s handover notes or an email message.

channel
A channel is a physical communications link between the server and one or more 
controllers.
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Command Zone
The right-hand part of the toolbar, where you can type commands.

console
A console is a group of Console Stations and Console Extension Stations 
associated with an Experion server.

controller
A controller is any of a series of devices (Honeywell controllers, third-party 
programmable controllers, and so on) that can be interfaced to the server to 
control and collect data from field devices. See “Introducing Experion and 
Station” on page 18.

display object
A discrete item on a display, such as a button or indicator, that is associated with a 
point or a command. See “Understanding display objects” on page 54.

double-click
The act of momentarily pressing the left mouse button two times. This is the 
standard way, in Windows, of selecting an object and performing an action. For 
example, to display the details about a particular alphanumeric, you move the 
pointer over the alphanumeric and then double-click—this displays a window 
which shows the object’s details.

drag
The act of pressing and holding down the mouse button, diagonally moving the 
mouse, and then releasing the mouse button. This is a standard way, in Windows, 
of resizing a window, or selecting an area of the screen.

event
An event is any significant change in the system, including any commands you 
issue.

full item name
In your asset model, the full item name consists of the item name of the entity 
combined with the item name of its parent, and so forth, up to a top level node. A 
full item name uniquely identifies an entity within the system. For example, 
Assets/Plant/Filtration/Tank/FlowMeter.

focus
In computing, focus means to “mark” an object so that it can be used or controlled 
in some way. For example, if you want to type data into a box, you need to give it 
focus so that the text/number you type is inserted into that box.
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item name
An item name is an intuitive name given to a point which can be used as an 
alternative to the tag name. The item name does not have to be unique.

Process Controller
In an Experion Process system, the term used to refer to both a C200 or C300 
controller.

Points on a Process Controller are called “process points”.

process point
An Experion Process point. (A point on a Process Controller.)

MD (mode)
The point parameter that determines whether or not you can change the point’s 
OP (output). For example, you can change the OP if the MD is set to manual, but 
not if it is set to automatic.

Message Zone
The line below the toolbar where explanatory messages and prompts appear.

Navigation Pane
The section to the left of system displays that is reserved for menus. Clicking an 
entry in the Navigation Pane calls up the associated display.

You can call up the top-level Navigation Menu by clicking the yellow triangle at 
the top of the panel.

OP (output)
The point parameter that represents the output value of a point. For an analog 
point this is typically a value between 0 and 100 representing a valve position 
between fully closed and fully open. For a status point this is typically a 0 or 1 
representing OFF or ON.

parameter
An item of information about a point, such as its PV (process value) or 
SP (setpoint)

point
A point is a collection of information about a particular part of your system, such 
as a control loop or motor. See “About points” on page 56.
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PV (process value)
The point parameter that represents the point’s value, expressed in a meaningful 
form—for example, if a point represents temperature, the PV would be expressed 
in degrees; if a point represents a motor’s status, the PV might be “On” or “Off”.

right-click
The act of momentarily pressing the right mouse button. What happens depends 
upon where you right-click. For example, in Station right-clicking selects the next 
object in a “tab sequence”. See “Using your mouse (or its equivalent)” on 
page 39.

scanning
The technique used to obtain data from any controller other than a Process 
controller.

SP (setpoint)
The point parameter that represents the desired value of a point. For example, if 
you wanted to change a boiler’s temperature you would change the SP to the 
desired temperature.

Status Line
The Status Line provides an overview of your system’s status. For example, a 
flashing red box indicates that there is at least one unacknowledged alarm. See 
“The Status Line” on page 31.

System Menu
The System Menu is a specialized display that provides quick access to the other 
major displays—it is equivalent to the Table of Contents of a book.

Click the  button on the toolbar to call up the System Menu.

tag name
A unique identifier given to an entity, for example a point or an asset. 
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A
Acknowledge/Silence Alarm button 33
acknowledging

alarms 78
messages 101

alarms
acknowledging 78
Alarm Line 29
Alarm Summary button 33
described 65
responding to 65
status (Status Line) 31

alphanumeric, described 54
archiving

archiving events to tape 92
requesting a report 152
restoring archived events 93
status 91
using extended event 90

Associated Display button 33

C
calling up

displays 49
files 52
Point Detail display 113
Point History 114
Web pages 52

Callup Display button 34
channel

described 134
disabling a failed 134
status, monitoring 134

chart, described 54
Command Zone

commands 162
described 29
using 35

commands

choosing from the menu 158
commands (Command Zone)

entering 35
list of 162

communicating with colleagues 149
communications link (channel) 134
communications status (Status Line) 31
Console Station, described 21
controller

disabling a failed 137
status, monitoring 137

custom displays, described 19

D
date and time (Status Line) 31
Detail/Search button 35
disabling

channel 134
controller 137
point 58
printer 145

display objects
alphanumeric 54
button 54
chart 54
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described 54
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list 54
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displays 49
reports 153
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calling up 49
custom 19
described 19
Group Detail 120
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INDEX

system 19, 48
Trend Set 121, 122
using 47

distributed systems, described 147

E
electronic signatures

described 61
using 62

Enable/Disable button 34
events

described 81
responding to 81

export report files 155
Extended Event Archiving 90

F
faceplates 119
files, calling up 52
finding a point 162
focus (term described) 166

G
Group Detail displays

described 120
Group button 34

H
help, displaying 43
history, displaying point 114
HTML files, calling up 52

I
indicator, described 54
item, searching for 42

K
keyboard

shortcuts to commands 164
types of 41
using 41

L
loading recipes 129
logging off

Operator-based security 26
Station-based security 27

logging on
Operator-based security 25
Station-based security 27

Lower button 34

M
maximizing the Station window 36
menu commands

described 29, 158
Message Pad

described 149
Message status (Status Line) 31
Message Zone, described 29
messages

acknowledging 101
described 95
in Message Zone 30
types of 38

minimizing the Station window 36
monitoring

channel status 134
controller status 137
printer status 145
redundant system 146
Station status 140
system status 133

mouse, using 39
moving the Station window 36
multi-window Station, described 30, 51

N
Navigate Back button 34
Navigate Forward button 34

O
Operator-based security 24
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P
Page Down button 34
Page Up button 34
parameters, point

changing 58
described 56
types of 56

password
changing another user’s password 174
changing your password 26

Point Detail displays
calling up 113
described 113
process 114

points
controlling 58
described 56
detailed information about 111
faceplates 119
finding 162
history, displaying 114
parameters 56
Point Detail displays 113
process 114
types of 56

printer status, monitoring 145
printing displays 53
process point

described 56
Detail display 114

R
Raise button 34
recipes

described 129
loading 129

redundant system, monitoring 146
Reload Page button 34
reports

described 151
export as files 155

export report files 155
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Print As Report option 155
requesting 152
standard 154
using 151

viewing (calling up) 153
Reset button 34
resizing the Station Window 36
responding to

alarms 65
events 81
messages 95

restoring the Station window 36

S
SafeBrowse

described 52
using 52

searching for
point 162
system item 42

security, Station
logging on (Operator-based) 25
logging on (Station-based) 27
privileges 27
types of 24
user levels 27

server
distributed, described 147
number (Status Line) 31

Set button 34
setup file, Station 28
shortcuts, keyboard 164
signatures

dual 61
electronic 61

Station
described 19
monitoring its status 140
setup file 28
starting 23
user security 24

Station Window
main parts 29
resizing 36
Status Line 31
toolbar 33
zooming in and out 37

Station-based security 24
Status Line

described 29
parts 31

status, monitoring system 133
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system
distributed, monitoring 147

system displays
described 19
types of 48

system item, searching for 42
System Menu

button 33
described 49

system status, monitoring 133

T
tampering, checking for 94
toolbar button

Enable/Disable 34
toolbar buttons

Acknowledge/Silence Alarm 33
Alarm Summary 33
Associated Display 33
Callup Display 34
Detail/Search 35
Group 34
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Navigate Back 34
Navigate Forward 34
Page Down 34
Page Up 34
Raise 34
Reload Page 34
Reset 34
Set 34
System Menu 33
Trend 34
Zoom 35
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trackball, using 39
Trend button 34
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described 121
modifying 122
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U
user (Station)

privileges 27
security levels 27

Status Line indication 33
using

keyboard 41
mouse 39
touch screen 40
trackball 39

V
viewing (calling up)

displays 49
reports 153

W
Web page

calling up 52
printing 53

Z
Zoom button 35
zooming in and out 37, 127
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